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Introduction 

 
Background 

 
On October 31, 1989 the Environmental Protection Agency (EPA) issued final rules for 
radionuclide emissions to air under 40 CFR 61, National Emission Standards for Hazardous 
Air Pollutants (NESHAPS). Emission monitoring and compliance procedures for Department 
of Energy (DOE) facilities (40 CFR 61.93(a) ) require the use of CAP-88 or AIRDOS-PC 
computer models, or other approved procedures, to calculate effective dose equivalents to 
members of the public. 

 
The CAP88 (which stands for Clean Air Act Assessment Package - 1988) computer model is 
a set of computer programs, databases and associated utility programs for estimation of 
dose and risk from radionuclide emissions to air. EPA modified the ORNL mainframe 
program AIRDOS in 1979 to create AIRDOS-EPA (Mo79). The AIRDOS-EPA code was further 
modified to incorporate various dose and risk coefficients. AIRDOS-EPA (1982) used 
RADRISK (1980) database files for dose and risk coefficients. RADRISK calculated isotope 
dose and risk and stored them in binary card image format. The DARTAB (1981) code was 
developed to convert RADRISK files to the format used by AIRDOS-EPA. AIRDOS (1984) 
used doses from DARTAB rather than the doses calculated directly by AIRDOS. 

 
To make compliance calculations easier for individuals without access to a mainframe 
computer, EPA developed the AIRDOS-PC program that was used from 1982 to 1986. 
AIRDOS-PC was succeeded by AIRDOS2 which was the predecessor of CAP88-PC. At the 
same time PC versions of RADRISK and DARTAB were developed. All were combined in 
CAP88-PC (1988). 

 
Purpose and Version History 

 
The original CAP88-PC software package, version 1.0, allowed users to perform full-featured 
dose and risk assessments in a DOS environment for the purpose of demonstrating 
compliance with 40 CFR 61.93(a). CAP88-PC provided the CAP-88 methodology for 
assessments of both collective populations and maximally-exposed individuals. The 
complete set of dose and risk factors used in CAP88 was provided. CAP88-PC differs from 
the dose assessment software AIRDOS-PC in that it estimates risk as well as dose, offers a 
wider selection of radionuclide and meteorological data, provides the capability for collective 
population assessments, and allows users greater freedom to alter values of environmental 
transport variables. CAP88-PC version 1.0 was approved for demonstrating compliance with 
40 CFR 61.93(a) in February 1992. 

 
CAP88-PC version 2.0 provided a framework for developing inputs to perform full-featured 
dose and risk assessments in a Windows environment for the purpose of demonstrating 
compliance with 40 CFR 61.93(a). The changes from version 2.0 to version 2.1 included the 
addition of more decay chains, improvements in the Windows code error handling, and a 
modified nuclide data input form. 

 
CAP88-PC Version 3.0 marked a significant update to the version 2 system. Version 3 
incorporated dose and risk factors from Federal Guidance Report 13 (FGR 13, EPA99) in 
place of the RADRISK data that was used in previous versions. The FGR 13 factors were
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based on the methods in Publication 72 of the International Commission on Radiological 
Protection (ICRP72). In addition, the CAP88-PC database, user interface, and input/output 
files were modified to accommodate the FGR 13 data formats and nomenclature. 

 
CAP88-PC Version 4 was a significant modification to version 3 intended to improve 
usability, increase stability, update the datasets, and provide a more maintainable code 
base and documentation set for the future. Version 4 adopted age-dependent dose and risk 
factors and introduced a new code architecture that conformed to updated coding standards 
and data formats. Version 4 also moved the database of isotopic data to eXtensible Markup 
Language (XML) format to enhance portability. Version 4.1 updates the dose/risk data to 
incorporate the DCFPAK 3.02 release of the FGR 13 information, and includes usability 
enhancements. 

 
Model Summary 

 
All versions of CAP88-PC use a modified Gaussian plume equation to estimate the average 
dispersion of radionuclides released from up to six emitting sources. The sources may be 
either elevated stacks, such as a smokestack, or uniform area sources, such as a pile of 
uranium mill tailings. Plume rise can be calculated assuming either a fixed, momentum, or 
buoyant-driven plume. Assessments are done for a circular grid of distances and directions 
for a radius of up to 80 kilometers (50 miles) around the facility. The Gaussian plume model 
is simple to use, has been widely tested, and has been shown to give reasonable predictions 
if a proper selection of model parameters is made (Faw99). 

 
The mainframe version of CAP88 consisted of three independent programs; the atmospheric 
dispersion program AIRDOS, the dose calculation program DARTAB, and the input 
preparation program PREPAR. There are a few differences between all versions of CAP88-PC 
and the mainframe versions of AIRDOS, PREPAR and DARTAB. The PREPAR program has 
been eliminated and replaced by a graphical user interface in CAP88-PC versions 2 through 
4.1. Population assessments are easier to perform in all versions of CAP88-PC. When 
performing population assessments, population arrays must always be supplied to the 
program as a file; for backward compatibility the population files still use the same format 
as those from the mainframe version of CAP88. Sample population files are supplied with 
CAP88-PC, which the user should modify to reflect their own population distributions. When 
performing population dose assessments, all versions of CAP88-PC use the distances in the 
population array to determine the sector midpoint distances where the code calculates 
concentrations. The AIRDOS dispersion module used in all versions of CAP88-PC only uses 
circular grids to define the assessment area, whereas square grids were available in the 
mainframe version. When an individual assessment is run in any version of CAP88-PC, the 
sector midpoint distances are input by the user and the sector boundary distances are 
calculated by CAP88-PC. Direct user input of radionuclide concentrations is not an option in 
any version of CAP88-PC. 

 
All versions of CAP88-PC have the capability to vary Radon daughter equilibrium fractions; 
previously they were set to a constant fraction value of 0.7. The new method varies the 
equilibrium fractions depending on the distance from the source. Linear interpolation is used 
to determine the equilibrium fractions for distances that do not match the set distances 
given. 

 
Agricultural arrays of milk cattle, beef cattle and agricultural crop area are generated 
automatically, requiring the user to supply only the State name or agricultural productivity 
values. When a population assessment is performed, the arrays are generated to match the
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distances used in the population arrays supplied to the code, and use State-specific or user- 
supplied agricultural productivity values. The state name (standard two letter abbreviation) 
must be provided. Users are given the option to override the default agricultural 
productivity values by entering the data directly on the Agricultural Data tab form. If Alaska, 
Hawaii, or Washington, D.C. is selected, agricultural productivity values are set to zero and 
must be provided by the user. 

 
CAP88-PC has been modified from the mainframe version to be capable of performing either 
"Radon-only" or "Non-Radon" runs in order to conform to the format of the 1988 Clean Air 
Act NESHAPS Rulemaking. "Radon-only" assessments are cases having Rn-222 as the only 
release isotope; including any other isotope in the release list cause CAP88-PC to consider 
the case as "Non-Radon". Cases that are "Radon-only" assessments perform calculations of 
Working Level and report Working Level in the output reports. Input of any other isotopes, 
including Radon-220, will cause CAP88-PC to omit calculations of Working Level. Synopsis 
reports are automatically customized based on whether the case is "Radon-only" or "Non- 
Radon". Version 4.1 has not changed the "Radon-only" methodology relative to previous 
versions. 

 
The calculation of deposition velocity and the default scavenging coefficient is defined by 
current EPA policy. Deposition velocity is set to 3.5e-2 m/sec for Iodine, 1.8e-3 m/sec for 
Particulate, and 0.0 m/sec for Gas. The default scavenging coefficient is calculated as a 
function of annual precipitation, which is input on the Meteorological Data tab form. Version 
4.1 has not modified these calculations, but the data formats introduced in Version 4.0 
permit future updates to include element or isotope dependent deposition velocities. 

 
Organs and weighting factors have been modified beginning with Version 3 to comport with 
the FGR 13 data supplied by Oak Rifge National Laboratory. In accordance with the FGR 13 
dose model, the code now calculates dose for 25 internal organs, rather than the 23 organs 
in Version 3 and the 7 organs used in earlier versions. A "26th" organ is also calculated, 
which is the total effective dose equivalent; this was the 24th organ in version 3. The code 
now reports cancer risk for the 15 target cancer sites used in FGR 13. As was the case in 
previous versions, changing the organs and weights will invalidate the results. Version 4.1 
adopted the radionuclide physical data, dose factors, risk factors and decay chain 
information provided by Oak Ridge National Laboratory in the DCFPAK Version 3.02 data 
release (Eck13). This data provides a more comprehensive set of dose and risk coefficients 
as compared to the DCFPAK 2.2 data used in Version 4.0. Version 4.1 retains the ability for 
the selection of age-dependent dose, risk, and ingestion data first introduced in CAP88-PC 
Version 4.0. 

 
Food chain dose is calculated using the methodology of Regulatory Guide 1.109 published 
by the US Nuclear Regulatory Commission. 

 
Validation and Testing 

 
The various CAP88-PC programs represent one of the approved, validated codes for the 
purpose of making comprehensive dose and risk assessments verifying compliance with the 
radionuclide NESHAPS. The Gaussian plume model used in CAP88-PC to estimate dispersion 
of radionuclides in air is one of the more commonly used models in Government 
guidebooks. It produces results that agree with experimental data for long-term releases, is 
fairly easy to work with, and is consistent with the random nature of turbulence. CAP88-PC 
Version 4.1 has not modified the basic Gaussian plume algorithm used by the AIRDOS
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module of CAP88-PC since Version 1. Comparison cases between versions 1, 2, 3 and 4 
have shown no significant changes in the dispersion calculations. 

 
The Office of Radiation and Indoor Air has made comparisons between the predictions of 
annual-average ground-level concentration to actual environmental measurements, and 
found very good agreement. In the paper "Comparison of AIRDOS-EPA Prediction of 
Ground-Level Airborne Radionuclide Concentrations to Measured Values" (Be86), 
environmental monitoring data at five Department of Energy (DOE) sites were compared to 
AIRDOS-EPA predictions. EPA concluded that, as often as not, AIRDOS-EPA dispersion 
predictions are within a factor of 2 of actual concentrations. 

 
The results generated by Versions 4.0 and 4.1 have been verified by an extensive software 
testing program performed at both the module and program level. Formal software testing 
was performed by independent reviewers who were not involved in the development of the 
code. Software testing involved testing the user interface; verifying that that the results of 
the atmospheric model dispersion and environmental transport models were correct; 
verifying that the radioactive decay and decay product calculations were correct; verifying 
that the dose and risk calculations were correct; and testing that the migration tool was 
properly reformatting Version 3 datasets and ancillary files into Version 4.0 or 4.1 formats. 
The testing program has been documented in a testing report supplied to EPA. EPA then 
proceeded to perform its own independent quality testing program. This program consisted 
of development of a review plan, which after approval by EPA management, provided an 
independent review of the code, including identification of potential problems or issues with 
the functionality of the code. Corrective actions were then taken, and the results of the 
quality procedures, including independence of the reviewers, are available from EPA. 

 
The software engineering and testing program used in the development of CAP88-PC 
Version 4.0 and 4.1 was implemented both to verify the code was producing the proper 
results and to upgrade the quality assurance status of the CAP88-PC program. Previous 
version of CAP88-PC were developed prior to the implementation of the more rigorous 
software quality requirements now being put in place by many organizations. In order to 
meet these more rigorous quality assurance requirements, the results from CAP88-PC 
Version 4.0 amd 4.1 were tested against not just black-box sample problems, but also hand 
calculations and spreadsheet models of the various calculations performed by the different 
code modules. The FORTRAN calculation modules of the code were developed using dual- 
confirmation coding, where all coding changes are performed by two individuals, one coding 
and one verifying the code as it is entered. As a result of using this method the FORTRAN 
subsystem in Version 4 has been subject to a line-by-line verification for over 90% of the 
active FORTRAN code. The sections not independently verified are contained in the DLSODE 
numerical solver libraries obtained from Lawrence Livermore National Laboratory (Ra93). 
Code configuration control and versioning was managed using the Visual SVN and GIT 
source control systems. Error tracking and resolution during the testing phase was managed 
in a dedicated Microsoft Sharepoint issue resolution list with versioning status and automatic 
notification of updates. 

 
Limitations 

 
Like all models, there are some limitations in the CAP88-PC system. 

 
While up to six stack or area sources can be modeled, all the sources are modeled as if 
located at the same point; that is, stacks cannot be located in different areas of a facility. 
The same plume rise mechanism (fixed, buoyant, or momentum) is used for each source.
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Also, area sources are treated as uniform. Variation in radionuclide concentrations due to 
complex terrain or local building wakes is not modeled. 

 
Errors arising from these assumptions typicalle have a small effect for assessments where 
the distance to exposed individuals is large compared to the stack height, area or facility 
size. In general, the model has significant higher uncertainty for receptors that are within 
two stack heights of the release point. 

 
Dose and risk estimates from CAP88-PC are applicable only to low-level chronic exposures, 
since the health effects and dosimetric data are based on low-level chronic intakes. CAP88- 
PC should not be used for either short-term or acute high-level radionuclide intakes. 

 
Summary of Version 2.1 Changes from Version 2.0 

 
Version 2.1.of CAP88-PC is an incremental change from Version 2.0, meaning that no 
significant modifications were introduced to the algorithms for calculating transport, uptake, 
dose, and risk. The changes have primarily been improvements to the Visual Basic code 
which performs the user interface and data collection functions. Some small changes were 
made to the FORTRAN calculation routines in order to accommodate variable input for 
humidity and to permit greater numbers of nuclides in a dataset. Additionally, the database 
files that are part of CAP88-PC's data management system have been updated to be more 
widely compatible with various versions of Windows. Some important modifications to the 
CAP88-PC code in Version 2.1 include: 

 
          More extensive input field checking for valid values 
 An error handling routine was added to provide a text file output of errors 

encountered by the code. Most errors are written to a file named 
"YYYYMMDDErrorlog.txt", where the date code refers to the date when the error 
occurred. This file is located in the CAP88-PC install directory 

 Many updates to the directory structure, which provided more installation flexibility 
and better default initialization in the selection boxes for custom wind and population 
files. 

 Added an absolute humidity entry on the Met Data tab for site specific calculation of 
tritium concentration in vegetables. 

 Added a user selectable distance and sector (JLOC and ILOC) option for the 
individual assessment case. Setting these to non-zero values cause the code to 
provide results for the distance and sector indicated. 

          Increased the number of radionuclides allowed in a run to 120 from 36 
          Incorporated the Year 2000 patch needed by Version 2.0 
          Eliminated all third-party functions and software packages that were in the Version 

2.0 Visual Basic code 
          Eliminated the dialog box that asked the user if they wanted to use MS-DOS mode 
          Updated and shortened the initial splash screen 
 The toolbar is located at the top of the window in accordance with Windows standard 

practice 
 The data environment (the accompanying database) was updated to Microsoft Access 

for greater compatibility with Windows 
 The "Open From File" option was added to allow the user to open input datasets that 

have not yet been included in the drop-down file list of available cases 
 The default directory locations for the wind and population library were changed to 

be the default install directories for these files.
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 The radionuclide entry method was changed. Rather than enter data directly into the 
Nuclide Data tab, the user selected either "Add Nuclide", "Edit Nuclide" or "Delete 
Nuclide" from the buttons on the form. When "Add Nuclide" or "Edit Nuclide" were 
selected, a new data entry form containing all selectable data for the nuclide was 
presented. 

 A new "Save and Close" button was placed on the Nuclide Data tab of the input data 
form. 

 
The user interface for Version 2.1 was built in Visual Basic 6.0, and the install package was 
made using InstallShield 7.2. The installer technology was updated and tested with all 
Windows versions from 95(b) to XP. It checked for some necessary Windows components, 
such as DCOM and Windows Scripting, and installed these if needed, eliminating the 
requirement for a separate installation of the DCOM98 module. 

 
Summary of Version 3 Changes from Version 2.1 

 
CAP88-PC Version 3 was a significant update to the previous version 2.1. Version 3 
incorporated all the Version 2.1 updates listed in Section 1.6, along with the following 
additional modifications: 

 
 Version 3 expanded the nuclide database to 825 nuclides, including all FGR 13 decay 

chains 
 Version 3 internally calculated all the FGR-13 decay chains using a modified Bateman 

solution 
          Version 3 was the first CAP88-PC code to perform calculation of the build-up factors 

on a case-specific basis for all isotopes in all chains 
          Incorporation of the new FGR 13 dose and risk factors 
 User-selectable analysis time period (default 100 years to maintain consistency with 

previous versions) 
          User-selectable length of the decay chains were first included in Version 3 
 User-selectable time step length for the calculation of build-up factors was first 

included in Version 3. 
          Version 3 eliminated the calculation of Genetic Effects 
 Dose factors were a function of radionuclide chemical form wherever that is included 

in the FGR 13 database 
          Organ dose equivalent was calculated for 23 internal organs 
          Cancer mortality risk is calculated for 15 cancer sites 
          The radionuclide inhalation absorption "Class" terminology was replaced by the new 

"Type" nomenclature. The new types were F (fast), M (medium), and S (slow), and 
are analogous to the older classes D (day), W (week), and Y (year). 

          All particulate sizes are 1.0 micron per the FGR 13 model data, except gases and 
vapor forms which are 0. 

 Default values for all radionuclide inputs were included; these defaults corresponded 
to the recommended values from FGR 13 wherever a recommendation was available. 

          The radionuclide transfer factors for all elements in the CAP88-PC database were 
updated to the values from the National Council on Radiation Protection and 
Measurement (NCRP) report number 123 (NCRP96). 

 The nuclide input form was modified to allow selection of the nuclide absorption type 
and the nuclide chemical form wherever dose factors based on multiple values of 
these are included in the database 

          Version 3 contained additional data for: 
o Age dependent dose factors
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o Dose factors for additional pathways such as drinking water ingestion and 
external exposure from multiple depths of soil contamination. 

o Dose factors for external exposure to infinite clouds 
o Cancer morbidity risk factors in addition to mortality risk factors 

 
CAP88-PC Version 3 continued to report data in the format and nomenclature used in 
previous versions. This was done to retain conformance of the model to the applicable 
regulation, 40 CFR Part 61 Subpart H. Accordingly, the dose factors used in version 3 for 
reporting dose to the maximum exposed individual and the populations were the values in 
FGR 13 for adults. The risk values reported by Version 3 and later were those for mortality, 
not morbidity. It is important to note that, because of the extensive data modifications, 
Version 3 did not allow the use of case input files created under earlier versions to be used 
as input for Version 3. Previous POP and WIND files were still useable. 

 
Summary of Version 4 Changes from Version 3 

 
CAP88-PC version 4 not only added significant features, but also redesigned the interface to 
give the user a more standard experience. The entire user interface module was re-written 
for Version 4 using VB.Net, the Microsoft .Net Framework version 4, and the Visual Studio 
2010 development environment, in order to more comply with installation and security 
requirements in Windows 7 and Windows 8. 

 
To conform to the Windows 7 security requirements, and to improve usability, the following 
significant changes were made: 

 
             Version 4 could only be installed on Windows XP SP3 and later. 
          Run Data is stored in the user's profile folders, rather than in the application's 

Program Files folder. This was required because Windows Vista and 7 security 
improvements restrict writing files to the Program Files folder. 

 To improve management of runs, datasets are by default stored in their own folders, 
as subfolders of the Datasets folder. 

          Reports (formerly "Output") are always stored in the same folder as the dataset. 
          Population and Wind files can be stored with the dataset, or in the default 

Population/Wind folders. Storing them with the dataset enhances the configuration 
control for a case by eliminating file commingling, and improves sharing dataset info 
between organizations. A user can send a dataset, its population and wind files, and 
its reports to another user, who can open them confident that the right files for that 
case are being used. 

 
Note that, like version 3, version 4 is not backward compatible. This is due to many factors, 
including the addition of age-specific data and the inclusion of many more nuclides than in 
previous versions. However, Version 4 introduced a dataset migration utility that upgrades 
many version 3 datasets to the version 4 format. 

 
More improvements include: 

 
Modeling 

 
 Inclusion of all DCFPAK Version 2.2 nuclides. Nuclides in the database having 

external but not internal dose factors are now flagged to the user rather than
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crashing the run. NOTE: the user must account for internal dose resulting from 
intake of these radionuclides using other methods, such as surrogates. 

          Age-specific data is now returned for dose, risk, and inhalation/ingestion rate values. 
 Nuclide Release Rates less than 1.000e-25 Ci/yr (e.g. "0") or greater than 7.92e+28 

are no longer allowed. 
          A FORTRAN numerical solver is now used to calculate decay-in-flight and ground 

build up concentrations for each sector. The time for decay in flight is calculated 
using the annual Pasquill category-averaged wind speed for each direction. 

 Up to 500 radionuclides can be included in any case. The 500 limit includes both the 
nuclides released by the stacks and their progeny. 

 Whole body and organ dose and risk factors are from DCFPAK Version 2.2. The data 
include six age groups; infant (100 days old), 1 year old, 5 years old, ten years old, 
fifteen years old, and adult. 

          Age-specific inhalation and ingestion data developed by the U.S. Environmental 
Protection Agency has been included for the above age groups. 

 The FORTRAN computational code has been consolidated into one module and 
variable names made consistent throughout the module. . Data transfer between the 
routines was streamlined by the use of Include statements for COMMON block 
variables. 

          All nuclide-specific data are now stored in eXtensible Markup Language (XML) 
format. 

 All significant floating-point calculations have been moved to the FORTRAN routines, 
greatly speeding up the code. 

          The code uses the Intel FORTRAN Composer XE 11 compiler that permits many of 
the calculations to be vectorized and multi-threaded to take advantage of these 
capabilities in modern desktop processors. 

 The bit-length of variables has been doubled, allowing much greater computational 
ranges for cases with large or small release rates. 

 
User Interface 

 
 A traditional document-style interface has been designed, similar to major 

applications with which users are already familiar. Users can more easily open, edit 
and save datasets, population and wind files using the Windows menus and familiar 
icons on the application bar. 

 Dataset reports are now displayed in, and generated from, a Reports tab when the 
dataset is opened. The code is now executed using the Report generation button 
rather than a “Save and Close” button. The reports to be generated and viewed are 
selectable from the Reports tab. The “Save and Close” button from Version 3 has 
been removed. 

          Multiple files (datasets, population files, wind files) can be open at once. 
          When editing files, changes and errors are displayed in real time. 
 Editing of nuclides is clearer and easier. In-grid editing is allowed, but note that 

fields are not recorded until the user clicks away from the field being edited. A Save 
performed without first clicking away from a filed being edited will result in that 
field’s data not being saved. 

 The application recognizes when a user is opening a version 3 file, and offers to 
create a version 4 copy of the file. 

 The general layout, look, and feel of the user interface are similar to that in earlier 
versions of CAP88-PC in order to ease transition to CAP88-PC Version 4. 

 
File Formats
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 The dataset file format changed in Version 4 from Version 3 to accommodate the 
new requirements. The new dataset file format was documented both in the manual 
and the on-line help files. 

 Population and Wind files previously had extended values such as State and Census 
stored in a Microsoft Access database. When migrating from version 3, this data--if 
available--is stored in the dataset file itself. Doing so removed the need for an 
external database, and allowed users to send their custom population/wind files with 
the extended values intact. These changes were documented in the file format 
description in the user manual and the on-line help files. 

          Version 3 population and wind files could still be used in version 4 datasets. 
Extended values are only added to the pop/wind files if they are edited to add them. 

 The use of additional applications, such as Microsoft Access, to manage data was 
eliminated in CAP88-PC Version 4. Radionuclide, agricultural, and other data 
previously held in the Microsoft Access database is now in a more portable and more 
easily accessible XML database. 

 
Summary of Version 4.1 Changes from Version 4.0 

 
Version 4.1 retains the major architectural, data handling, and user interface updates 
introduced in Version 4.0. Version 4.1 also implements a new Wix installer technology that 
enhances compatibility with Windows 10 and possible future Windows updates. 

 
Specific changes from Version 4.0 visible to the user in Version 4.1 include: 

 
User Interface 

 
 Replaced the Print button on the Reports tab with one that opens the folder holding 

the report files; 
          Modified some labels in hte user interface for clarity; 
          Improved capabilities for migrating datasets from previous versions of CAP88-PC 

including automatic conversion of version 4.0 datasets to version 4.1. 
 
Reports 

 
          Modified some report headers for clarity; 
 The Agricultural Data in the Synopsis report now prints the values used in the 

calculation, which may have been adjusted by CAP88-PC from the input values. 
 
Data 

 
 Updated the dose and risk coefficients from DCFPAK 2.2 to those in DCFPAK 3.02 

provided by Oak Ridge; 
          Dose and risk coefficient data was added for 151 more isotopes; 
          Risk coefficient data was added for more isotopes and forms beyond the additional 

151; 
          Updated inhalation coefficients for radionuclides with special chemical forms such as 

Iodine. 
 
Error Handling
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CAP88-PC Versions 4.0 and 4.1 contain an internal error logging and tracking system. In the 
case of internal code errors, the code will write errors to a file in the Message Log folder 
located in the same folder set as the folder containing the datasets. Sending this file to the 
EPA representative will facilitate troubleshooting. 

 
Installation 

 
Download Location 

 
CAP88-PC 4.1 can be downloaded from the following EPA web site: 
http://www.epa.gov/radiation/assessment/CAP88/index.html 

 
System Requirements 

 
          Windows 7 
          Windows 8 and 8.1 
          Windows 10 
          .NET Framework version 4 or later. 
 CAP88-PC is written as a 32-bit x86 architecture application. The 32-bit version can 

be run under 64-bit versions of Microsoft Windows 7, 8, 8.1, and 10. 
          Monitor resolutions of 1024x768 or higher 

 
CAP88-PC 4.1 is not supported with Microsoft Windows operating system versions earlier 
than those listed above. However, version 3 data files can be migrated to a new version 4.1 
installation. 

 
Installation Procedure 

 
CAP88-PC 4.1 can be installed side-by-side with CAP88-PC 3 but should not be with Version 
4.0. Version 4.1 is an in-place upgrade of version 4.0, and will automatically update Version 
4.0 dataset, population or wind files upon use, but does not automatically update Version 3 
dataset, population, or wind files upon use. Updating Version 3 files to Version 4.1 is done 
using the Migration Utility that runs on first installation or on demand under the 'Tools' item 
on the main menu bar. In some cases, the Migration Utility will fail because of a bug in the 
Microsoft Access Database Engine installation needed to perform the direct V3-to-V4.1 data 
migration. Special instructions for overcoming this problem are provided below and in the 
Readme file that is part of the installation package. It is strongly recommended that you 
upgrade your Version 3 installation to Version 4 using the Migration Utility, and then, after 
confirming success, uninstall Version 3. 

 
Procedure to Fix Migration Utility Failure Caused by Access Database Engine 
Install Bug 

 
On most systems, to run the migration utility in Version 4.1, the system must first have the 
Access Database Engine installed. The V4.1 migration utility includes a button that will take 
the user to the Microsoft page from where the Access database Engine can be downloaded. 
Either (or both) 32/64-bit versions can be downloaded; the version you download and install 
should correspond to the Microsoft Office installation on the system. 

 
During installation of the Access Database Engine you may encounter an error stating that 
the installation failed because there are 32-bit Office applications installed (if you are trying

http://www.epa.gov/radiation/assessment/CAP88/index.html
http://www.epa.gov/radiation/assessment/CAP88/index.html


CAP88-PC 4.1 Documentation Page 14 of 103  

to install the 64-bit engine) or that you have 64-bit Office applications installed (if you are 
trying to install the 32-bit engine). The source of this problem is that the Access Database 
Engine installer may have installed both the 32-bit and 64-bit versions of the Office Click- 
To-Run Extensibility Component. 

 
To resolve this issue perform the following steps: 

 
 Go to Start > Run (or Winkey + R) where the Winkey is the windows key on your 

keyboard 
          Type "installer" (doing so opens the %windir%installer folder) 
          Verify the folder settings are making all files visible 
          Add the column "Subject" by a right-click on the column headers, click 'More", find 

"Subject" and add it 
          NOTE: make the column "Subject" at least 400 pixels wide 
 Sort on the "Subject" column and scroll down until you find the name mentioned in 

your error report, for example "Office 15 Click-to-Run Extensibility Component". 
 NOTE: The 64-bit version is shown as such in the name, the 32-bit version name 

does not include the size 
          Right-click the MSI to be removed and choose uninstall 

 
After removing the version blocking installation of the Access Database Engine, rerun the 
migration utility. 

 
General Installation Instructions 

 
In general, it is recommended to uninstall previous CAP88-PC Version 4.0 and 4.1 
installations prior to installing any updated version. 

 
Download the installation file to a temporary folder, such as My 
Documents\Downloads\CAP88-PC 4.1. Unzip the file into a folder. 

 
Before running the installation program, it is highly recommended to examine the 
README.txt file in the folder containing the unzipped installation program for information 
supporting the installation process. After checking the README.txt file, begin the installation 
process by double-clicking the executable file containing the program. It is recommended 
that the installing user have Administrator rights on the local machine 

 
The installation checks if .NET Framework 4 is installed. If not, it attempts to download and 
install it. In some cases you may need to manually install it from the Microsoft web site. 

 
Initial Setup Screen 

 
The initial setup screen is shown below. Check the box agreeing to the license terms to 
activate the Install button and proceed with the installation. The License Terms simply links 
to the EPA web site.
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After clicking Install you will likely see a User Account Control screen asking if you will allow 
the program to install. Verify the publisher is either Trinity Engineering Associates or USEPA 
and then permit the installation by clicking Yes. You will then proceed through the 
installation. 

 
Click Next at the welcome window. 
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The following screen selects the location for the CAP88-PC Version 4.1 program files 
installation. This is not the location for the data files. Accepting the defaults is 
recommended. However, you can change the installation location and the user security. 
Please note that 64-bit versions of windows will default to "Program Files (x86)" instead of 
"Program Files". Click Next when ready. 

 

 
 
Click Next to finish installation.
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After the program files installation is complete, click Close to exit the installer. You can now 
run CAP88-PC Version 4.1 to complete the data installation and, if a first run after 
installation, will automatically launch the Migration Utility. The Migration Utility has two 
functions; to migrate existing Version 3 data to Version 4.0 or 4.1, and to install the initial 
set of program and user data. The Migration Utility must be run after an initial installation in 
order to complete CAP88-PC setup. 

 
First Run 

 
The first time you run CAP88-PC Version 4.0 or 4.1 after installation a message will appear 
noting that this is the First Run. Click OK to continue, which will open the Migration Utility. 
The utility will be preset to upgrade from version 3 to version 4. Even if version 3 is not 
installed, the migration folder must be run to populate the CAP88-PC V4.0 or V4.1 data 
environment. A message window will inform the user of this need. 

 

 
 
Default Folders
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The default folder layout for CAP88-PC datasets, program data, and FORTRAN execution 
files is shown below (this is for data files, not the program files already installed). This 
structure is the recommended configuration. The user may change the location of the folder 
set by specifying the location of the top-level folder (My Documents in the default setup) 
but the sub-folder structure will remain the same. Note that My Documents (or just 
Documents) is typically under the user’s named folder in Windows, for example 
c:\users\username by default in Windows 7, 8, and 10. Your IT system policies may change 
the default location. After running the migration tool, it is also possible to change the 
settings through  tools->options. The migration utility may also be run manually from the 
tools>options menu to migrate version 3 files or write the version 4.0 or 4.1 files into the 
destination folders selected in the migration utility dialog. 

 
 

My Documents 
|_CAP88-PC 

|_Datasets 
|_Fortran 
|_Message Log 
|_Population Files 
|_Wind Files 

 
 
Uninstallation 

 
In order to prevent inadvertent deletion of datasets and results, the Uninstall process will 
uninstall only those files that were installed in the CAP88-PC program files location. Any 
extracted or created Population and Wind Files, as well as any Datasets and Report Files, 
will not be deleted from the user's data location, nor from the program files location. These 
other files must be manually deleted from the installed data folder structure. Uninstall is 
best performed using the Add/Remove Programs option in the Windows Control Panel 
(called Programs and Features in Windows 7 or under Settings -> Apps in Windows 10). 

 
To perform a complete reinstall, delete or rename any existing CAP88-PC data folders. 
Doing so will produce a first-time installation process when CAP88-PC V4.0 or V4.1 is re- 
installed. The user can also manually initiate the first-time install process from the Tools 
menu item by checking the "Is First Run" box under Tools->Options->Advanced. 

 
Migration Utility 

 
Tools > Migration Utility



CAP88-PC 4.1 Documentation Page 19 of 103  

 
 
The migration utility is used to move datasets, population, and wind files to new locations, 
and to upgrade their format from Version 3 to Version 4.0 or 4.1. It is typically used when 
CAP88-PC is first run. Note that only data files from the 12/9/2007 release of CAP88-PC 
Version 3 can be directly upgraded. If you have older datasets, try opening them in the 
12/9/2007 version and save the dataset to put it in the proper format. 

 
The conversion  Results contains information on which files were successfully migrated. It 
also includes, for each dataset, whether it fails to comply with version 4.0 or 4.1 validation 
rules. 

 
The utility will typically organize migrated files in the recommended way by creating the 
default or user-defined file system folders and populating the folders with the migrated 
data.



CAP88-PC 4.1 Documentation Page 20 of 103  

The Migration Utility also installs the standard datasets, population files, and wind files 
supplied as part ofthe CAP88-PC V4.1 release package. The user can select how these 
standard files get installed. By default, the standard data files supplied with the CAP88-PC 
installation system are not written into the data folders if a migrated file of the same name 
exists in the folder. 

 
When first opened, the destination folders are set to match the folders selected in Tools- 
>Options. 

 
Version 4 Migration/Destination Folders 

 
This section describes the process for selecting the migration utility input and output folder 
locations for the dialog box shown above. Using this dialog box the user can choose the 
location folders for the Version 4 Dataset files, the population files, and the wind files. The 
folders will initially be set to the values from the Tools->Options dialog, or the Cap-88 
Version 4 installation folder located in the User's "My Documents" folder structure. 

 
Dataset Destination Folder 

 
The target folder where the Version 4.1 dataset files will be placed. Click the [...] button to 
select a folder using Windows Explorer. It is recommended to use the default locations 
under the user’s Windows User account folder. 

 
Population Destination Folder 

 
The population file destination folder. Click the [...] button to select a folder using Windows 
Explorer. 

 
Wind Destination Folder 

 
The wind file destination folder. Click the [...] button to select a folder using Windows 
Explorer. 

 
Find Version 3 Sources 

 
Clicking this button causes the utility to attempt to locate the version 3 data files for 
migration. If not found, the user is prompted to specify the locations of the files to be 
migrated. 

 
Version 3 Data.mdb 

 
This is the Microsoft Access data file (commonly named Data.mdb) used in version 3 to 
store extended values for population and wind files. If available, it is used when upgrading 
those files. 

 
Copy Default Files 

 
If checked, the default population and wind files are copied from the installation location to 
the default folders.
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Migrate v3 Datasets 
 
If checked, the utility attempts to migrated datasets from the  Dataset Source folder to the 
Dataset Destination folder, using the selected options. 

 
Note that sample datasets from version 3 are not migrated. Instead, new versions have 
been created. 

 
Location 

 
This is the folder that contains the version 3 datasets. Click the [...] button to select a folder 
using Windows Explorer. 

 
Include Dataset Sub-Folders 

 
Check this box to include datasets in subfolders of the  Dataset Source folder. 

 
Upgrade Dataset Files 

 
Check this box to upgrade datasets to version 4.1. 

 
Overwrite Destination Dataset Files 

 
Check this box to overwrite files in the  Dataset Destination folder with files having matching 
names from the  Dataset Source folder. NOTE: If the user wishes to retain files in the target 
folder that may be overwritten, then these files should be backed up by copying to another 
location or renamed prior to migration. 

 
Include Dataset Population and Wind Files 

 
Check this box to migrate population and wind files used by the dataset. When migrating 
pop/wind files: 

 
1.  The utility first checks if the user is also migrating population and wind files. If so, 

and the file was in a corresponding Pop or Wind Source folder, the new file is created 
in the proper Pop or Wind Destination folder. 

2.  If not migrating, or not found in the Pop/Wind Source folder, the utility checks if the 
source file is in the same path as  Dataset Source and, if so, creates the new file in 
the same relative folder. 

3.  Finally, if neither of the above is true, the files are created in the same folder as the 
dataset. 

 
Upgrade Dataset Population and Wind Files 

 
If checked, the utility will attempt to find the pop/wnd file's extended values from the 
version 3 database, and write those values to the file. This option is disabled if the version 3 
database hasn't been located. 

 
Organize Dataset Files
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If checked, dataset files are organized according to the defaults. 
 
Migrate Reports 

 
If checked, the utility attempts to find and copy the dataset's reports. It looks in the 
following locations, in order. 

 
1.  The V3 Output folder, which is the default location in version 3. 
2.  The Dataset Source folder. 

 
Note: Reports are always copied to the same folder as the dataset. 

 
V3 Reports 

 
The location of the version 3 report (output) files. 

 
Migrate V3 Population Files 

 
If checked, the utility attempts to migrated population files from the  Pop Source folder to 
the Pop Destination folder, using the selected options. 

 
Location 

 
The folder that contains the version 3 population files. Click the [...] button to select a 
folder. 

 
Include Population Sub-Folders 

 
Check this box to include population files in subfolders of the  Pop Source folder. 

 
Upgrade Population Files 

 
Check the box to upgrade population files to version 4.1. The version 3 population files 
being migrated will need to be in the standard format produced by the version 3 population 
file editor in order to successfully migrate. Reading and parsing the files using the version 3 
population file editor will verify the format. Additional notable format requirements: A space 
must follow the $ in the first column of row 1. Lines 4 through 43 are right justified decimal 
values in fields of width 10. The decimal point is the last character in the field and acts as a 
delimiter. The final 10 lines should hold zero values in the same format as lines 4 to 43. For 
more on the population file format please see  Population File Format. 

 
Overwrite Destination Population Files 

 
Check this box to overwrite files in the  Pop Destination folder with matching files from the 
Pop Source folder. 

 
Migrate V3 Wind Files 

 
If checked, the utility attempts to migrated wind files from the  Wind Source folder to the 
Wind Destination folder, using the selected options.
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Location 
 
The folder that contains the V3 wind files. Click the [...] button to select a folder. 

 
Include Wind Sub-Folders 

 
Check this box to include wind files in subfolders of the  Wind Source folder. 

 
Upgrade Wind Files 

 
Check this box to upgrade wind files to version 4.1. 

 
Overwrite Destination Wind Files 

 
Check this box to overwrite files in the  Wind Destination folder with matching files from the 
Wind Source folder. 

 
Run 

 
Click this button to run the migration. 

 
Migration to Version 4.1 of the old Access database files used in Version 3 requires updated 
versions of the Microsoft Access Database Engine. The Version 4.1 Migration Utility prompts 
the user at this step to determine if downloading and installing these updated drivers is 
necessary. If a previous Version 3 installation is not resident on the machine or if the user 
decides no migration of version 3 data is necessary and de-selects the V3 data migration 
option, then no V3-to-V4.1 migration will be performed. Downloading and installing 
these drivers is not required, and not recommended, if no upgrade of Version 3 
data is being performed as part of this V4.1 installation. 

 
Some versions of the Access Database Engine downloaded from Microsoft may fail to 
properly allow the Migration Utility to run. This is caused by a bug in the Access Database 
Engine installer whereby it installs both the 32-bit and 64-bit versions. Proper operation 
requires installation of only the version matching the installed version of Microsoft Office (32 
or 64-bit). The procedure for resolving this problem is described in the  Installation topic. 

 
Stop 

 
Click this button to stop a running migration. 

 
Word Wrap 

 
Check this box to wrap results text. Uncheck to show each message on its own line. 

 
Results 

 
This text box displays the results of the conversion. When a conversion is completed, the 
results are written to a file located in the Message Logs folder. The file is named Migrate 
Files [datetime].txt, where [datetime] is the date and time of the conversion in the ISO
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standard format YYYYMMDD-HHMMSS. Below are examples from the beginning and end of a 
migration.
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See Also Options 
Dataset Folder Organization



 

Pop/Wind Search Order 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
CAP88-PC 4.1 Documentation                Page 26 of 103



CAP88-PC 4.1 Documentation Page 27 of 103  

Usage 
 
Main Form 

 

 
 
This is initial application view. It is a standard multi-document interface, with a menu and 
toolbar. 

 
Important note: if you begin editing a field in a form, the change is not persisted until you 
click away from the field on the form itself. If the user clicks on a save button first, the in- 
process edit will revert to the previous value. 

 
Errors: If an error occurs that you would like technical help on, please  click here for further 
instructions
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The menu bar contains a 'Tools' dropdown that allows access to many special functions 
including the ability manually run the Migration Utility, identify the location for installation 
folders and data folders, and view data on the population and wind files. More information 
on some of the funcitons within the 'Tools' menu bar selection are in 

 
Options 

 
Tools > Options 

 

 
 
Dataset Folder Organization (Recommended) 

 
Datasets are recommended to be put into their own folders. A dataset's reports are always 
stored in the same folder as the dataset. The corresponding population and wind files should 
be stored in the default Population and Wind folders. 

 
 

Datasets 
|_ModTest1 

|_ModTest1.dat 
|_ModTest1.SYN 
|_ModTest1.WEA 

|ModTest2 
|_ModTest2.dat 
|_ModTest2.CHI 

 
 
Population and Wind File Search Order 

 
A dataset's population and wind files should be located in one of two places: 

 
          In the same folder as the dataset file, OR 
          In the default folder set in Options
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The full path to these files is stored in the dataset. If a complete dataset (.dat, .pop, .wnd, 
and report files) needs to be opened on another machine, it's recommended that all related 
files be kept in one folder. If this is done, then CAP88-PC will find and use the correct files. 

 
When opening a dataset that references population and wind files (and reports), the 
program searches for the files in this order: 

 
1.  Exact path match 
2.  In the same folder as the dataset 
3.  In the user's default folder defined in their Options. 

 
General 

 
Dataset Folder 

 
This is the folder for dataset files. The image shows the locations following a default 
installation. 

 
FORTRAN Folder 

 
This folder contains the FORTRAN executable code. If the FORTRAN files are not seen in this 
folder, or if a patch to the FORTRAN is released, the FORTRAN can be replaced or updated 
using the Refresh Fortran button under Advanced. The FORTRAN code can also be run 
manually from the command line. 

 
See Also Dataset Reports 
FORTRAN Executables 

 

 
 
Population/Wind Files 
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Population Files Folder 
 
This folder contains the population files. Check "Include sub-folders" to include files in 
folders below the main folder. 

 
Wind Files Folder 

 
This folder contains the wind files. Check "Include sub-folders" to include files in folders 
below the main folder. 

 
See Also Dataset Edit Population Tab 
Dataset Edit Meteorological Tab 
Population File List 
Wind File List 

 

 
 
Advanced 

 

 
 
Message Log 

 
This folder contains the error message log, and the First Run log. Error messages are in a 
text file named Cap88v4Log.txt. The log contains the latest messages, and older messages 
are deleted to make room for new ones. If you experience a problem, emailing a copy of 
this log to support personnel may help troubleshoot the problem. 

 
Is First Run 

 
If checked, the application will execute its "First Run" utility, which sets default folders and 
upgrades existing version 3 files. Only check this if you have backed up your files and are 
aware of the risk of data loss should unexpected interruption occur during the file upgrade 
process.
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See Also  Installation First Run 
 

 
 
Refresh Fortran 

 
Copies the FORTRAN files to the user's Fortran folder, overwriting the existing files. 

 
Refresh Upgrade 

 
Refreshes changes to the user's CAP88PC folders made during the last upgrade. Changes 
could include new/modified sample datasets and new default pop/wnd files.This also 
refreshes the FORTRAN files. 

 
Dataset 

 
Dataset Open/New 

 
File > Open > Dataset 
File > New > Dataset 

 

 
 
To open an existing dataset: 

 
1.  Choose Open > Dataset, OR 
2.  Click the toolbar's Open icon. The default action is to open a dataset. 

 
To create a new dataset: 

 
1.  Choose File > New > New Dataset, OR 
2.  Click the toolbar's New icon. The default action is to create a new dataset. 

 
Dataset Edit 

 
File > Open > Dataset 
File > New > Dataset
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The dataset edit form is composed of multiple tabs. The Dataset tab, shown above, displays 
last save and report generation date times. 

 
>NOTE: When entering or modifying data in a field within the CAP88-PC user 
interface, the data is not retained in the form until the user clicks away from the 
form field. 

 
Changes Last Saved 

 
The last date/time changes to the file were saved. The date/time doesn't update if the file is 
saved with no changes. 

 
Reports Last Generated
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The last date/time reports were generated. 
 
Dataset Save 

 

 
 
To save a dataset, click File > Save, File > Save As, or the toolbar Save button. After 
saving, the Dataset tab shows the last save datetime. This datetime only changes if the 
dataset, itself, had changes. 

 
A file cannot be saved if it has errors. Errors are displayed in the ERRORS status box, and 
also next to the field(s) with errors, as shown below. 

 

 
 
Important note: if you begin editing a field, the change is not recorded until you click away 
from the field on the form itself. If the user clicks on the save button first, the in-process 
edit will revert to the previous value. 

 
Dataset Edit Facility Tab
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The Facility tab is used to describe the facility and time period to be modeled. 

 
Address Information 

 
The fields available for entering address information are: Name, Address1, Address2, City 
and Zip. 

 
Note: State is found on the  Agricultural tab. 

 
Comments 

 
There are two lines available for short comments. 

 
Emission Year 

 
The year emissions were recorded. 

 
Source Category
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A text field used to store user-defined categories. 
 
Dataset Edit Population Tab 

 

 
 
The Population tab is used to describe the population to be assessed and select optional 
reports. 

 
Run Type 

 
A dataset either uses data from a population file by choosing "Population", or the user can 
manually enter population data by choosing "Individual". 

 
Population Age 

 
Selects the specific age for which dosage information is reported. Values are: 

 
          Infant (100 days) 
          One (year) 
          Five (years)
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          Ten (years) 
          Fifteen (years) 
          Adult (20+ years) 

 
File 

 
If  Run Type is "Population", this drop down is displayed, and lists the available population 
files. If a file is in the same folder as the dataset, it's marked with an asterisk. 

 
If a dataset is opened that has a reference to a file, but the file isn't found, the original path 
and file name will show in ERRORS. This may happen if a dataset is opened on a computer 
that's different from where it was created. 

 
See Also Population and Wind File Search Order 

 

 
 
Distances 

 
Indicates the number of non-zero population distances in the  Midpoints. 

 
Midpoints 

 
Displays the population mid point data derived from the population file, or entered by the 
user if "Individual" is selected. If "Population" is selected, these fields are read-only. 

 
The distances entered must be contiguous and ascending, that is, no cells can be skipped 
and the midpoint distances must increase from left to right in each row. 

 
A quick way to get a starting point for "Individual" mid points is to first set  Run Type to 
"Population", choose a file with data approximating what is needed, then change Run Type 
to "Individual". The population files values will be retained, and can then be adjusted. 

 
Maximum Exposed Individual 

 
When Run Type is "Individual", the user can explicitly set the location of the maximum 
exposed individual in the population area. This is done by unchecking "Auto-determine", and 
selecting the Direction and Midpoint distance. If "Auto-determine" is checked, then CAP88- 
PC will calculate the maximum exposed individual. 

 
Build Up Time 

 
The default value of 100 years is the value specified in the regulatory model for CAP88-PC 
assessment (the NUREG 1.109 approach). Using a value other than 100 years in this field 
will invalidate the run for compliance purposes. The option to change this field is provided 
only to permit future use of the code for modeling, and to allow users to use CAP88-PC as a 
means of generating decay sets for other purposes. 

 
Report Selections
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Check which reports should be generated in addition to the Synopsis, General and Weather 
reports. 

 
Dataset Edit Meteorological Tab 

 

 
 
File 

 
This drop down displays the list of available wind files. If a file is in the same folder as the 
dataset, it's marked with an asterisk. 

 
If a dataset is opened that has a reference to a file, but the file isn't found, the original path 
and file name will show in ERRORS. This may happen if a dataset is opened on a computer 
that's different from where it was created. 

 
See Also Population and Wind File Search Order 

 

 
 
Annual Precipitation 

 
The average annual precipitation (in centimeters) at or near the site. 

 
Annual Ambient Temperature 

 
Average annual ambient temperature, in degrees Celsius, at or near the site. 

 
Lid Height 

 
The height of the tropospheric mixing layer (in meters) at or near the site.
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Absolute Humidity 
 
The absolute humidity (in grams / cubic meter) at or near the site. Typical values are from 
3 grams/cu m to 20 grams/cu m. 

 
Dataset Edit Sources Tab 

 

 
 
The Sources tab is used to identify the type of emitting source and the dimensions of each 
emitting source being assessed. Stack and Area Sources cannot be mixed in a single 
assessment. While up to six stack or area sources can be modeled, all the sources are 
modeled as if located at the same point. The same plume rise mechanism (Buoyant, 
Momentum, Fixed, or Zero) is used for each source. Also, area sources are treated as 
uniform. Variation in radionuclide concentrations due to complex terrain cannot be modeled. 
Errors arising from these assumptions will have a negligible effect for assessments where 
the distance to exposed individuals is large compared to the stack height, area, or facility 
size. 

 
Source Type 

 
The emitting sources must be identified as stacks (point) or area sources. While up to six 
stack or area sources can be modeled, all the sources are modeled as if located at the same 
point. The same plume rise mechanism (Buoyant, Momentum, Fixed, or Zero) is used for 
each source. Also, area sources are treated as uniform. 

 
Sources 

 
Up to six emitting sources (stacks or areas) may be modeled. The fields for Height, 
Diameter/Area, and Plume Rise Type (if Momentum or Buoyant) change as the number of
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emitting sources change, so select the number of sources before entering any associated 
data. 

 
Source Values 

 
For each source, enter the Height (meters), and the Diameter (meters) or Area (meters 
squared). 

 
Plume Type 

 
Select the Plume Rise Type for the dispersion modeling. The choices are Buoyant, 
Momentum, Fixed, and Zero. The same plume rise mechanism is used for each source. 

 
Plume Type Values 

 
Enter the plume rise values for each type. 

 
          Buoyant: heat release rate in calories/sec 
          Momentum: exit velocity in meters/sec 
          Fixed: plume rise in meters for each Pasquill Category 
          None: zero is entered for each Pasquill Category 

 
Dataset Edit Agricultural Tab
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The Agricultural tab is used to enter agricultural factors that will be applied to the dispersion 
data to estimate uptake of emitted radionuclides into the food chain. 

 
Food Source 

 
Selection of each EPA Food Source Scenario (Urban, Rural, Local, Regional, and Imported) 
will result in different fractions that describe the fraction of Vegetable, Milk, and Meat 
produced in the area, or imported to the area. The user may manually generate the food 
source scenario by selecting the Entered scenario. 

 
Food Source Fractions 

 
The food source fractions are not editable unless the Entered scenario is selected, in which 
case fractions must be entered by the user. The Entered fractions must total to 1.0 for each 
column. CAP88-PC may recalculate the input food source fractions should the productivity of 
the local or assessment area be insufficient to produce enough food to meet the population 
times the consumption rates. The input food source fractions are printed in the General 
report. The actual fractions used in the dose calculations are printed in the Synopsis report. 

 
Agriculture State 

 
Sample distributions of beef and milk cattle densities, and crop productivity, are provided by 
EPA for the assessment area using average agricultural productivity data for each of the fifty
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states. Since data was not available for Alaska, Hawaii, and the District of Columbia, the 
user must supply relevant agricultural data for these areas. 

 
Beef Cattle Density 

 
The beef cattle density for the assessment area. 

 
Milk Cattle Density 

 
The milk cattle density for the assessment area. 

Land Fraction Cultivated for Vegetables 

The crop productivity for the assessment area. 

Dataset Edit Nuclides Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Nuclides tab is used to select and describe characteristics of the radionuclides emitted 
by each source. 

 
Chain Length 

 
Sets the maximum depth of the decayed chains used in the analysis. Setting to "max" uses 
the complete chains. Changing this setting updates the  Decayed Chains value 

 
Radon Only
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This check box is only available if nuclide Rn-222 is the only nuclide in the list. Checking this 
box causes CAP88-PC to produce "Radon-Only" reports. 

 
Released Nuclide Count 

 
The number of nuclides in the list. 

 
Total Nuclide Count 

 
The sum of the complete decay chain for each nuclide in the list, to the depth specified in 
Chain Length. For example, if the Chain Length were "max", and the nuclides in the list 
were Fe-60, Co-60m and Co-60, the Decayed Chains count would be 6: Fe-60 has three 
nuclides in its chain, Co-60m has two, and Co-60 has one. Changing the Chain Length to 2 
would reduce Decayed Chains to 5, because Fe-60 would only include its first two nuclides. 

 
It is strongly recommended to use a Chain Length of 3 or higher. 

 
Note that the maximum number of nuclides allowed depends on their decay chains and the 
value selected for  Chain Length. The maximum allowed Total Nuclide Count is 500. 

 
Delete Rows w/All 0 RR 

 
CAP88-PC requires a row to have at least one non-zero release rate. In some cases, a user 
may want to add only a few nuclides in a long chain. An easy way to accomplish this is to 
add the complete chain, enter the release rates for the desired nuclides, and then use 
"Delete Rows w/All 0 RR" to remove the undesired nuclides, i.e. the ones where all release 
rates are zero. 

 
Add/Remove Nuclide 

 
To add a nuclide, select it from the list and click the Add button. The user can type inside 
the text box to find a nuclide in the list. If the nuclide is part of a chain, the user is 
prompted whether to add the entire chain. 

 

 
 
To remove a nuclide, place the cursor in its row and click the Remove button. If the nuclide 
is part of a chain, the user is prompted whether to remove the entire chain. Note: If 
removing a chain, the entire chain is removed, even if the nuclide is not at the top of the 
chain. When prompted to remove a chain, the user can choose to only remove the selected 
nuclide.
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Nuclides 

 
The user can directly edit the properties for each nuclide in the grid. The "Chn" (chain id) 
and "Nuclide" values are read-only. The editable properties are listed below. If a nuclide 
does not have internal (ingestion/inhalation) dose coefficients, Chemical Form and Type will 
be blank, and size will be zero. 

 
See Decay Chains 

 
Chem Form 

 
The chemical form of the nuclide. 

 
Type 

 
The type of the nuclide's chemical form. If particulate, then this will be one of the FGR 13 
types (F)ast, (M)edium or (S)low. If an inhalant, the type will be (G)as or (V)apor. 

 
Size 

 
If the chemical form is a particulate, the size can be any of the values 0.001, 0.003, 0.1, 
0.3, 1, 3, 5, 10, 30, 50, 100. If the chemical form is not a particulate, the size will be zero. 

 
Release Rate 

 
The release rate in Ci/year, corresponding to the source column in the  Sources Tab. A value 
must be at least 1.0e-25, but can't be greater than approximately 7.92e+28. 

 
Dataset Edit Reports Tab
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The Reports tab is used to generate the assessment reports. CAP88-PC will always create 
Synopsis, General and Weather reports. Which output reports to generate is selected in the 
Population Tab. 

 
Select option "Current" to print the currently displayed report. Select option "Selected" to 
print one or more reports. Only checkboxes for available reports will be enabled. 

 
Version 4.1 has removed the ability to print reports directly from the application interface. 
Many printer drivers do not properly render the page feed in the report files, causing a print 
error. The recommended approach is now to open the report files in any program that can 
handle ASCII text files (most word processors and file editors) and print from that 
application. The report files can be accessed using the "View Reports" button.
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Reports can only be generated if the dataset has no outstanding changes or errors. After 
generation, the Reports Last Generated datetime will be updated, and the dataset will be 
saved. 

 
Population File 

Population File List 

Tools > Population File List 

 
 
The Population File List displays the population files located in the folder location selected 
during installation in  Options. The columns can be sorted both ascending and descending by 
clicking on column headings. 

To edit a file, double click on its row. 

See Also Population File Edit 
Options 
Population and Wind File Search Order 

 

 
 
Population File Edit 

 
Access this function by drilling down the menus: 
File > New > Population File 
File > Open > Population File
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Use this form to edit new or existing population files. Besides using the menu and toolbar, 
Population Files can also be opened from  Population File List. 

 
See Also Population File List 
Population File Format 

 

 
 
Population File Edit Location Tab
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Name 

 
The source of the population. 

 
Location* 

 
The specific location for the population. 

 
City* 

 
The population city. 

 
State* 

 
The population state. 

 
Latitude 

 
The latitude of the population location. 

 
Longitude 

 
The longitude of the population location. 

 
Census*
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The census year the population values were gathered. 
 
Comments* 

 
Other comments about the file. Note that manual line breaks will be converted to spaces. 

 
*Note: The population file contains both standard and "extended" data. Extended fields are 
only used and created by CAP88-PC, and are indicated with an asterisk. 

 
See Also Population File Format 

 
 
 
Population File Edit Distances Tab 

 

 
 
Use this tab to edit the distances used in the population file. CAP88-PC uses these values to 
generate Midpoints. 

 
Midpoints 

 
Population midpoints are calculated as follows: 

 
1.  Add the distance to its preceding distance (zero, if calculating midpoint 1) 
2.  Divide by 2 

 
For example, Midpoint 1 = (Distance 1 plus zero)/2, i.e. 250 = (500 + 0)/2. Midpoint 5 = 
(Distance 5 + Distance 4)/2, i.e. 3500 = (4000 + 3000)/2. 

 
See Also Population File Format
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Population File Edit Direction Values Tab 
 

 
 
Use this tab to enter the populations at specific distances and directions. Each row is a 
direction, and each column is a distance specified in the  Distances Tab. 

 
See Also Population File Format 

 

 
 
Wind File Wind 

File List Tools > 

Wind File List
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The Wind File List displays the wind files located in the default folder selected in  Options. 
The columns can be sorted both ascending and descending by clicking on the column 
headings. 

To edit a file, double click on its row. 

See Also Wind File Edit 
Options 
Population and Wind File Search Order 

 
 
 
Wind File Edit 

 
File > Open > Wind File
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Use this form to edit existing Wind files. Besides using the menu and toolbar, Wind Files can 
also be opened from  Wind File List. 

 
Note: Unlike Population Files, Wind files cannot be created manually using the CAP88-PC 
editor. They must be created using a separate text editor or by editing an existing file. 

 
Note: The wind file contains both standard and "extended" data. Extended fields are only 
used and created by CAP88-PC. All fields below are extended fields. 

 
Station Name 

 
The name of the weather collection stations. 

 
State 

 
The station's state. 

 
Latitude 

 
The station's latitude. 

 
Longitude 

 
The station's longitude. 

 
Time Zone
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The station's time zone. 
 
Record Period 

 
The period reflected in the data file's values. 

 
Avg. Period Temp 

 
The average temperature for the  Record Period, in degrees Celsius. 

 
Comments 

Other comments about the file. Note that manual line breaks will be converted to spaces. 

See Also Wind File List 
Wind File Format
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Version CAP88/file version major-minor, e.g. 4.1 1 1 var 
 
Dataset FileNamePrefix 

The dataset's file name without “dat”, 
includes trailing “.” Used when naming 
report files. 

 
2 

 
1 

 
var 

Last Change Date date of last time Dataset info changed. 
Format: mmm d, yyyy hh:mm am/pm 
Jan 03, 2010 03:08 pm 

3 1 var 

Last Run Date date of last time the Dataset had been 
executed, i.e. output files generated 
Format: mmm d, yyyy hh:mm am/pm 

4 1 var 

Facility 
Facility Name Facility Name 5 1 var 
Facility Address 1 Address 1 6 1 var 
Facility Address 2 Address 2 7 1 var 
Facility City City 8 1 var 
Facility Zip Zip code 9 1 var 
Source Category The Source Category is for information 

only. No particular category is enforced 
at this time. 

10 1 var 

Emission Year the year in which the radionuclide 
emissions occurred 

11 1 4 

Comment 1 Comment 1 12 1 var 
Comment 2 Comment 2 13 1 var 
Population 
 
Run Type 

Individual=0 
Population=1 
Right justified 

 
14 

 
1 

 
var 

Population File Population file path and name 15 1 var 
 
 
 
 
Population Age 

String value: 
Infant 
One 
Five 
Ten 
Fifteen 
Adult 

 
 
 
 
16 

 
 
 
 
1 

 
 
 
 
var 

Build Up Time In days, Integer 17 1 var 
 

Reference 
 
Dataset File Format 

 
Line and Col are both 1-based. 

 
          Each property is on its own line in most cases. 
          Decimal values are almost always scientific notation, 0.000e+00. 
          Lines with multiple columns are logical groupings, such as Plume values. 
          No wrapping of like columns, i.e. no 80-column limit. 
          Column values are left-justified unless otherwise noted. 
          Whenever possible, columns are length ten, or multiple of ten. 

 
Field                                   Purpose                                                Line  Col   Len



 

 

Population Distance Count 
(NRADS) 

Population file's NRADS value (number 
of distances) Integer 

 

18 
 

1 
 

var 

 
 
 
 
 
 
 
 
 
 
Max Exposed Direction 
(ILOC) 

ILOC and JLOC are parameters used in 
DARTAB to specify the maximum 
exposed individual. They refer to 
indexes that determine the direction 
(ILOC) and distance (JLOC) to the 
individual. 
 
ILOC is 1 for North, 2 for North 
Northwest, 3 for Northwest, etc. up to 
16 for North Northeast. 
 
JLOC is one for the first distance in the 
specified Midpoint Distances array, 2 for 
the second distance, etc. 
 
Set ILOC and JLOC to 0 to let DARTAB 
determine the distance and direction. 
Either both ILOC and JLOC must be set, 
or both must be 0. 

 
 
 
 
 
 
 
 
 
 
 
19 

 
 
 
 
 
 
 
 
 
 
 
1 

 
 
 
 
 
 
 
 
 
 
 
var 

Max Exposed Midpoint 
(JLOC) 

 

The 1-based midpoint 
 

20 
 

1 
 

var 

MIDPOINTS For 1 to 20 
Midpoint1 Integer 21 1 10 
Midpoint2 Integer 21 11 10 
Midpoint3 Integer 21 21 10 
...Midpoint20 Integer 21 191 10 
Create organ dose 
summaries 

True = T 
False = F 

 

22 
 

1 
 

10 
 

Create dose and risk factors True = T 
False = F 

 

22 
 

11 
 

10 
 

Create concentration table True = T 
False = F 

 

22 
 

21 
 

10 
 

Create Chi/Q table table True = T 
False = F 

 

22 
 

31 
 

10 

Meteorological 
Wind File Wind file path and name 23 1 var 

 

Annual Precipitation The average annual precipitation (in 
centimeters) at or near the site. 

 

24 
 

1 
 

var 

Annual Ambient 
Temperature 

Average annual ambient temperature in 
degrees Celsius. 

 

25 
 

1 
 

var 
 

Lid Height The height of the tropospheric mixing 
layer (in meters) at or near the site. 

 

26 
 

1 
 

var 
 
 
 
Absolute Humidity 

The absolute humidity (in grams / cubic 
meter) at or near the site. This field 
must contain a positive non-zero value. 
Typical values are from 3 grams/cu m to 
20 grams/cu m. The default is 8 
grams/cu m. 

 
 
 
27 

 
 
 
1 

 
 
 
var 

Sources 
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Source Type Stack=0 
Area=1 

 

28 
 

1 
 

var 
 

Sources Count Up to six (6) emitting sources (stacks or 
areas) may be modeled. 

 

29 
 

1 
 

var 

SOURCE HEIGHTS For 1 to SourcesCount (x) 
SourceHeight1 Scientific 30 1 10 
SourceHeight2 Scientific 30 11 10 
...SourceHeightX Scientific 30 etc 10 
SOURCE DEPTHS (DIAMETER OR AREA) For 1 to SourcesCount (x) 
(Depth is "Diameter" if Type is Stack, or "Area" if Type is Area.) 
SourceDepth1 Scientific 31 1 10 
SourceDepth2 Scientific 31 11 10 
SourceDepthX Scientific 31 etc 10 
 
 
Plume Type 

Buoyant=0 
Momentum=1 
Fixed=2 
None=3 

 
 
32 

 
 
1 

 
 
var 

PLUME VALUES 1-7 
PlumeValue1 Scientific 33 1 10 
PlumeValue2 Scientific 33 11 10 
PlumeValue3 Scientific 33 21 10 
PlumeValue4 Scientific 33 31 10 
PlumeValue5 Scientific 33 41 10 
PlumeValue6 Scientific 33 51 10 
PlumeValue7 Scientific 33 61 10 
Agricultural 
 
 
Food Source 

Text: “Urban”, “Rural”, “Local”, 
“Regional”, “Imported”, “Entered” 
 
Notes: “entered” means the values were 
manually entered. 

 
 
34 

 
 
1 

 
 
var 

Vegetable fraction home 
produced 

 

Format 0.00 
 

35 
 

1 
 

10 

Vegetable fraction from 
assessment area 

 

Format 0.00 
 

35 
 

11 
 

10 

Vegetable Fraction imported Format 0.00 35 21 10 
Milk fraction home produced Format 0.00 36 1 10 
Milk fraction from 
assessment area 

 

Format 0.00 
 

36 
 

11 
 

10 

Milk Fraction imported Format 0.00 36 21 10 
Meat fraction home 
produced 

 

Format 0.00 
 

37 
 

1 
 

10 

Meat fraction from 
assessment area 

 

Format 0.00 
 

37 
 

11 
 

10 

Meat Fraction imported Format 0.00 37 21 10 
Agriculture State State. Abbreviation only 38 1 2 
Beef cattle density #/ha Format 0.000E-01 39 1 10 
Milk cattle density #/ha Format 0.000E-01 40 1 10 
Vegetable cultivated land 
fraction 

 

Format 0.000E-01 
 

41 
 

1 
 

10 

Nuclides 
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DecayStep Integer, number of seconds (not used in 
V4, kept for compatibility) 

 

42 
 

1 
 

var 
 

ChainLength Integer 
1 through 6, or 29 (max) 

 

43 
 

1 
 

var 

 
Radon Only Run 

Allowed if Rn-222 is the only nuclide. 
True = T 
False = F 

 
44 

 
1 

 
var 

Nuclides Count Integer 45 1 var 
NUCLIDES For 1 to NuclideCount (x) (two nuclides shown) 
NUCLIDE1 
ChainId1 Integer, used to group nuclides 46 1 10 
Name1 E.g. Rn-222 46 11 10 

 

Form1 Chemical form, e.g. "Tritiated Water 
Vapor" or "B" (blank) 

 

46 
 

21 
 

40 

Type1 E.g. F, M, S, V, G, B (blank) 46 61 10 
 

Size1 Decimal in format 000.0000, e.g. 
0.0001, 10.0000, 300.0000 

 

46 
 

71 
 

10 

----RELEASE RATES Nuclide1, For 1 to SourceCount (y) 
RR1 Scientific 46 81 10 
RR2 Scientific 46 91 10 
RRy Scientific 46 etc 10 
     
Age-Dependent Usage Rates - Combined Genders 
(a single row of age-specific data) 
Total Vegetables Integer 47 1 10 
Total Diary Integer 47 11 10 
Total Milk Integer 47 21 10 
Total Meat Integer 47 31 10 
Drinking Water Integer 47 41 10 
Inhalation Integer 47 51 10 
     
Decay Chains 
Each user-selected nuclide has its complete chain written out. For the parent, the user's 
settings (chem form, type, size) are used for coefficients. For daughters, the nuclide's 
defaults are used. 
 
NOTE: If Radon Only = True, then only the parent nuclide is written, i.e. Rn-222. 
 
 
Dose Organs 

The organ names that correspond to the 
dose coefficients. Each column left 
justified. 

 
48 

 
1-x 

 
10 

 

Risk Organs The organ names that correspond to risk 
coefficients. Each column left justified. 

 

49 
 

1-x 
 

10 

 
For each user-selected nuclide (1 to NuclideCount) 
Chain Count The number of nuclides in this nuclide's 

chain. If Radon Only, then this value is 
always 1. 

50 1 var 

For each nuclide in chain (parent and daughters) : 
NUCLIDE ATTRIBUTES All numeric values are in Scientific    
Name String 51 1 10 
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Default Chemical Form Chemical form, e.g. "Tritiated Water 
Vapor" or "B" (blank) 

 

51 
 

11 
 

40 

Default Inhalation Type E.g. F, M, S, V, G, B (blank) 51 51 10 
 

Default Size Decimal in format 000.0000, e.g. 
0.0001, 10.0000, 300.0000 

 

51 
 

61 
 

10 

HalfLife In Seconds 51 71 10 
Deposition Velocity  51 81 10 
Scavenging Coefficient  51 91 10 
Surface Removal Rate 
Constant 

 51 101 10 

Default Inhalation  51 111 10 
GI Ingestion  51 121 10 
BeefXfer  51 131 10 
MilkXfer  51 141 10 
VegetableXfer  51 151 10 
ForageXfer  51 161 10 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Branching Coefficients 

Format Scientific. 
1-dimensional 30-element array, which 
is the branching coefficient row for this 
daughter. Consider the whole chain as a 
two-dimensional array of 1 to 30 items, 
with nuclides down the left, and the 
same nuclides across the top. 
 
Each element in the array is the 
percentage decay from the parent. If no 
value, then zero is stored. For example: 
 
Sc-44m is the parent. It has one 
daugher, Sc-44. The branching 
coefficients for Sc-44m would be all 
zeros, because it's the parent: 
0 0 0 0 0 ... 
 
The branching coefficients for Sc-44 
would be: 
9.880E-01 0 0 0 0 ... 
 
This indicates that Sc-44 decays 9.880e- 
01 % from nuclide 1, which is Sc-44m. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
52 

 
 
 
 
 
 
 
 
 
 
 
 
 
1- 
301 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
10 

Dose Ingestion Coefficients For each organ 53 1-x 10 
Dose Inhalation Coefficients For each organ 54 1-x 10 
Dose Air Coefficients For each organ 55 1-x 10 
Dose Ground Coefficients For each organ 56 1-x 10 
Risk Ingestion Coefficients For each organ 57 1-x 10 
Risk Inhalation Coefficients For each organ 58 1-x 10 
Risk Air Coefficients For each organ 59 1-x 10 
Risk Ground Coefficients For each organ 60 1-x 10 

 
Quick Reference 
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Below is a simple, rough view of the dataset format. 
 
Version 
Dataset Filename 
Last Change Datetime 
Last Run Datetime 
Facility Name 
Address1 
Address2 
City Zip 
Category 
Emission Year 
Comment1 
Comment2 
Run Type 
Population Filename 
Population Age 
BuildUp Time 
Distance Count 
Max Exposed Direction 
Max Exposed Midpoint 
Midpoints 
ReportSummary  ReportFactors  RepConcentrations ReportChiQ 
Wind Filename 
Annual Precipitation 
Annual Temp Lid 
Height Absolute 
Humidity Source 
Type 
Source Count 
Source Heights 
Source Depths 
Plume Type 
Plume Values 
Food Source 
Veg fractions 
Milk fractions 
Meat fractions 
Agri State 
Beef Density 
Milk Density 
Veg Fraction 
Decay Step 
Chain Length 
Radon Only 
Nuclide Count 
Nuclides 

(ChainId Name Form Type Size RR1-6) 
(ChainId Name Form Type Size RR1-6) 
etc. 

 
[AGE-DEPENDENT USAGE RATES] 
TotVeg TotDairy TotMilk TotMeat Water Inhalation 

 
[DECAY CHAINS] 
Dose organ list 
Risk organ list 
For each user-selected nuclide: 

Decay Chain Count 
For each nuclide in chain: 

(Line 1, nuclide info)
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Name, Chem Form, Type, Size, Half Life, Deposition Velocity, Scavenging 
Coefficient, 

Surface Removal Rate Constant, Default Inhalation, GI Ingestion, 
BeefXfer, MilkXfer, VegetableXfer, ForageXfer 

 
(Line 2, branching coefficients) 
1x30 array, each element is the fraction decay from a parent nuclide 

 

Line 
Line 
Line 
Line 

3: 
4: 
5: 
6: 

Dose 
Dose 
Dose 
Dose 

Ingestion 
Inhalation 
Air 
Ground 

Line 
Line 
Line 

7: 
8: 
9: 

Risk 
Risk 
Risk 

Ingestion 
Inhalation 
Air 

Line10: Risk Ground 

 
Dataset Default File 

 
Purpose Of Default Value 

 
The DEFAULT.DAT file contains various types of default data for CAP88-PC. The file is 
divided into two segments. The first segment contains default values that can, with great 
caution, be changed by the user. The second segment contains permanent defaults which 
are values that must never be changed by the user since any changes would corrupt the 
assessments. 

 
User Changeable Defaults 

 
The defaults contained in the DEFAULT.DAT file for meteorological data, inhalation and 
ingestion rates, water use and agricultural productivity are the values approved by EPA to 
demonstrate compliance as required by 40 CFR 61.93(a). 

 
CAUTION: Any modification to the DEFAULT.DAT file must be approved by EPA if 
the modified parameters are used to demonstrate compliance per 40 CFR 
61.93(a), or any other NESHAP section which requires the use of CAP88 for 
regulatory purposes. 

 
There may be users who, in rare instances, might need to change one or more of these 
values for a specific purpose. The user, however, should be fully aware that these values 
must only be changed when and if the user fully understands the full impact that the 
change(s) will have upon the assessments run with the user specified values. 

 
CAUTION: If any of these values are changed without full knowledge of the impact 
of the change(s), the resulting assessments could be invalid for the intended 
purpose. 

 
Permanent Defaults 

 
The default values found in the second segment of the file contains defaults that must not 
be changed by the user. These values are contained in the DEFAULT.DAT file so that if 
directed by EPA, applicable defaults can be easily changed within this file and promptly
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disseminated to all users. This will preclude the necessity of modifying program code and 
disseminating new executable programs. 

 
Changeable Defaults 

 
Variable Names and Descriptions 

 
The following is a list of variable names whose values can be changed by the user. Also 
included are their units of measure, default values and a brief description. The variable 
names here will match the names you will see in the DEFAULT.DAT file. They are grouped in 
categories such as meteorological, agricultural, etc. 

 
VARIABLE UNITS DEFAULT DESCRIPTION 
TG oK/m .0728 Vertical temperature gradient for 
  .1090 Pasquill categories E, F, 
  .1455 and G (three element array) 
DILFAC cm 1.0 Depth of water for dilution for water immersion 

doses 
USEFAC  0.0 Fraction of time spent swimming 
ILOC  0 Direction index of the single location used for 

individual calculations 
JLOC  0 Distance index of the single location used for 

individual calculations 
PLOC  100.0 The percentile of the total risk to use in choosing 

the location for the exposure array used for the 
individual tables. When ILOC and JLOC are both 0, 
PLOC is used. 

GSCFAC  0.5 A scaling factor used to correct ground surface 
dose factors for surface roughness 

Default Rates 
BRTHRT cm3/hr 5.26E+03 Inhalation rate of man 
DD1  0.5 Fraction of radioactivity retained on leafy 

vegetables and produce after washing 
UF kg/yr 84.0 Ingestion rate of meat by man 
UL kg/yr 7.79 Ingestion rate of leafy vegetables by man 
UM liter/yr 53.0 Ingestion rate of milk by man 
UV kg/yr 76.2 Ingestion rate of produce by man 
Agricultural Defaults 
FSUBG  1.0 Fraction of produce ingested grown in garden of 

interest 
FSUBL  1.0 Fraction of leafy vegetables grown in garden of 

interest 
FSUBP  0.4 Fraction of year animals graze on pasture 
FSUBS  0.43 Fraction of daily feed that is pasture grass when 

animal grazes on pasture 
LAMW hr-1 2.9E-3 Removal rate constant for physical loss by 

weathering 
MSUBB kg 200.0 Muscle mass of animal at slaughter 
P kg/m2 215.0 Effective surface density of soil, dry weight 

(assumes 15 cm plow layer) 
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VARIABLE UNITS DEFAULT DESCRIPTION 
QSUBF kg/day 15.6 Consumption rate of contaminated feed or forage 

by an animal (dry weight) 
R1  0.57 Fallout interception fraction-pasture 
R2  0.2 Fallout interception fraction-vegetables 
TAUBEF  3.81E-3 Fraction of animal herd slaughtered per day 
TSUBE1 hr 720.0 Period of exposure during growing season-- 

pasture grass 
TSUBE2 hr 1440.0 Period of exposure during growing season--crops 

or leafy vegetables 
TSUBF day 2.0 Transport time: animal feed-milk-man 
TSUBH1 hr 0.0 Time delay--ingestion of pasture grass by animals 
TSUBH2 hr 2160.0 Time delay--ingestion of stored feed by animals 
TSUBH3 hr 336.0 Time delay--ingestion of leafy vegetables by man 
TSUBH4 hr 336.0 Time delay--ingestion of produce by man 
TSUBS day 20.0 Average time from slaughter of meat animal to 

consumption 
VSUBM liter/day 11.0 Milk production of cow 
YSUBV1 kg/m2 0.28 Agricultural productivity by unit area (grass-cow- 

milk-man pathway) 
YSUBV2 kg/m2 0.716 Agricultural productivity by unit area (produce or 

leafy vegetables ingested by man) 
TSUBB yr 100.0 Period of long-term buildup for activity in soil 

 
Changing Default Values 

 
The DEFAULT.DAT file is located in the CAP88PC directory of the drive you have chosen to 
load the system on. Go to this directory. Before you change anything in this file, you may 
want to make a copy of the original DEFAULT.DAT file giving it a different extension or save 
it on a floppy disk so that it can be easily retrieved. 

 
Access DEFAULT.DAT (an ASCII file) using a word processor or a text editor. Find the 
variable name whose value you want to change and simply replace the default value with 
the value you want to use. The following are some conditions the user needs to be aware of. 

 
 Additional digits can be included, exponential notation can be used in place of 

decimal numbers and decimal numbers can replace exponential notation. Integer 
values should remain integers. 

 Do not delete any variables. The program will not abort but either zero or some 
unpredictable value will be used which will invalidate the assessment results. 

 Do not move the variables around. They must remain in the original order and 
category. Each category begins with an Ampersand (&) followed by four or more 
descriptive characters. Each category ends with &END. The &END must follow the 
last variable in the category or be on a line by itself immediately following the last 
variable. 

 The beginning of a category must be at the beginning of a line and there must be 
one or more spaces separating it from the first variable in the category. 

 Do not change the order or delete any of the categories. If the order is changed or 
any category is eliminated the CAP88-PC system will abort and/or produce totally 
invalid assessment results.
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 Additional lines can be added and variables moved from one line to another as long 
as the order of the variables does not change. 

 There is no required number of spaces between variables but the variables must be 
separated by commas. A comma is not required between the last variable in a 
category and &END. 

          Be sure not to eliminate the equal (=) sign between the variable and the value or 
values in the case of an array. The variable TG is a three element array; therefore, 
TG is followed by a single = sign which is then followed by three values separated by 
commas. TG(1) will contain .0728, TG(2) and TG(3) will contain the next two values 
respectively. If any or all of these values should ever be changed, be sure the values 
are entered in the correct order. 

 Change only the variables listed in 10.2.1 (Variable Names and Descriptions). Do not 
alter in any way the variables and values in the categories that follow the &INPUT 
category. 

 
Save the user altered file into DEFAULT.DAT after making sure that you have saved the 
original DEFAULT.DAT so that it will not be destroyed by your altered file. The new file is 
then ready to be used with the CAP88-PC System. 

 
Restoring DEFAULT.DAT Values 

 
When an assessment is executed The DEFAULT.DAT file is checked for changes. If changes 
have been made to defaults listed in Section 10.2.1, the changes will be printed to the 
screen as shown in the figure below. 

 
 

W A R N I N G ! 
The Following Default Values Have Been Changed, 
DO NOT USE these changes unless you fully understand 
the EFFECTS of these Changes: 

 
These changes CANNOT BE USED to demonstrate compliance 
per 40 CFR 61.93 unless specifically approved by EPA. 

 
Inhalation Rate of Man 
Changed From: 9.1670E+05 
To:           8.5300E+05 

 
Resetting of individual defaults cannot be done here. 
CHANGE ALL DEFAULTS Back to their Original Values? 

 
Y/N: 

 
 
The changes shown will include the description, the original default value and the user 
specified value. After all changes have been printed to the screen, the user is given the 
opportunity to reset all defaults back to their original values with a response of Y or N. It is 
not possible to reset individual values at this point. Individual changes can only be made 
directly by accessing the DEFAULT.DAT file using a text editor or word processor as 
described in Section 10.2.2. 

 
If the user elects to have all defaults reset, all defaults will be overwritten with the original 
defaults. The overwritten DEFAULT.DAT file will look a little different from the original file; 
however, the only actual difference will be the spacing of the variables. The variable names 
and values will be closer together using fewer lines.
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Alternative DEFAULT.DAT Files 
 
The user may want to create alternative default files with user specified values. Before 
initiating the CAP88-PC system the user would copy the default file they need for a given 
run into DEFAULT.DAT. 

 
WARNING: CAP88-PC must have a DEFAULT.DAT file available in order for it to run. 

 
It is not possible to alter any of the specified default values once CAP88-PC has been 
initiated except to reset all defaults to their original values. Therefore, when a user needs 
alternative default values it is the user's responsibility to assure that the appropriate 
alternative DEFAULT.DAT file is available when CAP88-PC is initiated. 

 
When a DEFAULT.DAT file containing user altered default values is used, there will be a 
CAUTION message on the beginning page of the SYNOPSIS Report stating that defaults 
have been changed. The specific changes will be listed on the following page including the 
default description, the original default value, and the user specified value. This will alert 
the originators and anyone using the outputs that defaults have been changed and what 
changes have been made. 

 
PERMANENT DEFAULTS 

 
The DEFAULT.DAT file contains defaults that must not be changed by the user. All defaults 
beginning with &ORGAN through the end of the file must contain the original default values 
which can only be changed at the direction of EPA. 

 
 
Permanent Defaults that MUST NOT BE ALTERED by the user 
have been changed. They will be RESET to prevent CAP88-PC 
from producing invalid results. 

 
If any of the permanent defaults are changed, except at the direction of EPA, the CAP88-PC 
system will detect those changes and reset them to their original values. In this case, a 
message similar to the one shown above will be printed to the screen informing the user 
that these permanent defaults have been reset. If the user has changed default values 
defined as changeable by the user, the system will not reset those user changeable values 
except at the direction of the user. 

 
Population File Format 

 
Starting with CAP88-PC Version 4, extended data is included in the file. This data was 
previously stored in a separate database, preventing portability. All extended data is at the 
end of the file, after an "extended data" line. The format for the data is Setting=Value. 

 
Users are encouraged to use site-specific population arrays with CAP88-PC. Users who have 
been operating the CAP88 mainframe software may download their population files for use 
on the CAP88-PC system. They must be in the same format as the following file. However, 
extended values are not required. 

 
It is critical that all information be in the same exact locations with the “$” sign being in the 
first column of the first row of the file.
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0.5 1.0 2.0 3.0 4.0 5.0 10.0 20.0 
30.0 40.0 50.0 60.0 80.0    

0. 1. 0. 0. 0. 0. 0. 2705. 
2641. 3331. 3552. 5411. 55579. 0. 0. 0. 

0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 2333. 11675. 2212. 3061. 

7065. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 3071. 

1287. 2055. 1782. 5763. 24201. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 1033. 3288. 1529. 13828. 2949. 

9707. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 717. 1020. 

4615. 1333. 90022. 26249. 79387. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 797. 5611. 3905. 0. 861. 12543. 

176422. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 2602. 0. 573. 1137. 

328. 710. 3812. 6853. 16705. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 

2046. 0. 320. 1656. 1642. 976. 8788. 10199. 

 

The population file name, latitude, and longitude on row 1 are information only for the 
purpose of verifying that the file desired is the file the user has selected. 

 
NRADS is the number of distances within the population file. The value associated with 
NRADS must be in columns 68 and 69 of row 1 of the population file and the last digit must 
always found column 69 (right justified). 

 
Distances begin in row 2 and all numbers are right justified. The number of distances found 
in the file will be the number specified by NRAD. The distances are edge points of each 
sector (the Midpoints used in by CAP88 are calculated by the program) and are entered in 
the population file in kilometers. The CAP88 programs will multiply each distance by 1000 
before calculating the midpoints and using them in the assessment. For example, the first 
distance in the file, .62 kilometers, will become 620 meters and the midpoint calculated 
from that will be 310 meters. There can be up to 20 distances, but the typical number of 
distances is 13. 

 
The population values are entered with distances across (columns) and directions down 
(rows); however, each row will not be a new direction. There will be 20 distances for each 
direction (regardless of the number of distances specified in the population file). The extra 
distances (usually 7) will simply contain zero. There will always be 8 population values per 
row with the first value ending at column 10 and each subsequent value ending at multiples 
of 10 with the last value per row ending in column 80. This means that for the direction N, 
the population values will be contained on the first, second and part of the third row of the 
distance-direction population values. The first population value for the next direction, NNW, 
will be contained in columns 41 through 50 of the third row and subsequent values for 
direction NNW will be contained on the remaining part of the third row, the fourth and part 
of the fifth row. There are 16 directions in counterclockwise order starting with North. 

 
Sample Population File 

 
The following is the population file Battelle.POP used in the CAP88Def41 sample 
assessment. 

 
 

$ BATTELLE COLUMBUS        LAT= 39.9672 LON= 83.2500 NSEC=16 NRADS=13
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11921. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 

2807. 2199. 2176. 2809. 14890. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 55. 6325. 3726. 837. 11171. 1608. 

44798. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 4477. 5592. 

8271. 6486. 11446. 3399. 10303. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 4312. 55327. 36474. 18070. 12787. 22041. 

42086. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 3282. 84555. 

204255. 100483. 18087. 7393. 69779. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 677. 50903. 177302. 47221. 4039. 9908. 

20086. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 854. 20317. 

34864. 9203. 6955. 2119. 18770. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 2458. 4158. 2559. 12434. 13663. 5086. 

17946. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 
0. 0. 0. 0. 0. 0. 0. 0. 

extended data 
Location=Battelle Columbus Laboratory 
City=Columbus 
State=OH 
Census=1980 
Comments= 

 
 
 
Wind File Format 

 
Starting with CAP88-PC Version 4, extended data is included in the file. This data was 
previously stored in a separate database, preventing portability. All extended data is at the 
end of the file, after an "extended data" line. The format for the data is Setting=Value. 

 
Other than the extended data, the wind file format is not fully documented at this time. 
Known formatting is as follows: 

 
Item         Description                                                                               Line Col Len 
Magic 
Number 

Indicates this is a wind file. The three characters are ASCII 
hexadecimal values 01, 02 and 03, with no spaces in between. 

 

1 
 

1 
 

3 

 
Sample Wind File 

 
Below is the data found in file 03160.wnd. Note that the "magic number" on line one may 
not show any characters, depending on how you're viewing the documentation.
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4.27363 
0.05900.01810.03940.07870.08100.06820.12380.09540.06090.02820.02530.02410.03750.06360. 
10320.0936 
1.33 1.11 1.27 1.15 1.08 1.35 1.36 1.50 1.13 1.25 1.47 1.10 1.25 1.36 1.41 1.45 
1.47 1.33 1.25 1.38 1.25 1.39 1.33 1.50 1.45 1.24 1.34 1.23 1.51 1.71 1.85 1.62 
3.12 2.18 2.68 2.64 2.24 2.51 3.28 3.07 2.65 1.92 1.91 2.00 2.68 3.66 4.09 4.17 
6.07 3.43 4.29 4.77 4.19 4.69 6.02 5.91 4.68 3.68 3.25 3.42 3.87 5.17 6.15 6.89 
3.61 3.13 3.22 3.49 3.34 3.52 3.82 3.78 3.34 3.28 3.10 3.18 3.39 3.70 3.89 3.81 
1.26 1.24 1.26 1.39 1.38 1.38 1.40 1.43 1.34 1.35 1.14 1.17 1.28 1.36 1.37 1.20 
0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
1.85 1.56 1.78 1.62 1.50 1.87 1.88 2.02 1.59 1.76 1.99 1.53 1.75 1.89 1.94 1.97 
2.32 2.16 2.04 2.30 2.00 2.22 2.05 2.47 2.27 1.97 2.08 1.91 2.33 2.67 2.80 2.59 
4.92 3.23 3.66 3.84 3.39 3.44 4.17 4.12 3.67 2.88 2.78 2.84 3.58 4.66 5.45 5.69 
7.10 4.59 5.22 5.56 5.30 5.76 6.61 6.68 6.01 5.20 4.81 4.64 5.00 5.99 6.97 7.68 
3.83 3.35 3.45 3.72 3.57 3.75 4.00 3.97 3.58 3.52 3.32 3.41 3.63 3.91 4.05 4.00 
1.77 1.74 1.76 1.91 1.90 1.90 1.93 1.96 1.87 1.87 1.60 1.65 1.79 1.88 1.89 1.68 
0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 

0.0147   0.0903    0.1610    0.4659    0.1289   0.1392   0.0000 
0.0177   0.1546    0.1866    0.2087    0.1160   0.3164   0.0000 
0.0041   0.0921    0.1707    0.3293    0.1347   0.2692   0.0000 
0.0048   0.0441    0.0980    0.3522    0.1750   0.3258   0.0000 
0.0064   0.0468    0.0757    0.2085    0.1890   0.4736   0.0000 
0.0072   0.0419    0.0629    0.2029    0.2365   0.4486   0.0000 
0.0021   0.0247    0.0604    0.4410    0.2253   0.2465   0.0000 
0.0024   0.0343    0.0926    0.4362    0.1943   0.2402   0.0000 
0.0076   0.0765    0.1248    0.2351    0.1912   0.3649   0.0000 
0.0149   0.1377    0.1360    0.2001    0.1512   0.3601   0.0000 
0.0269   0.1766    0.1797    0.1971    0.1342   0.2854   0.0000 
0.0295   0.2431    0.2003    0.1816    0.1222   0.2232   0.0000 
0.0181   0.2258    0.2490    0.2474    0.1017   0.1580   0.0000 
0.0157   0.1323    0.2612    0.3845    0.1053   0.1009   0.0000 
0.0069   0.0772    0.2351    0.5318    0.0916   0.0574   0.0000 
0.0051    0.0742    0.1790    0.6065    0.0828   0.0525   0.0000 

extended data 
StationName=DESERT ROCK 
State=NV 
Latitude=36.617 
Longitude=116.017 
TimeZone=8 
RecordPeriod=1988,1989,1990,1991,1992 
AveragePeriodTemperature=17.64 
Comments= 

 
 
 
 
Architecture and Mathematical Models 

 
The purpose of this chapter is to present the code architecture, mathematical models, and 
equations used in CAP88-PC for environmental transport and estimation of dose and risk. In 
order to facilitate comparison of the programs with the theoretical model by interested 
users, the actual variable names used in the CAP88-PC FORTRAN code have been included 
in brackets, where applicable, following the explanation of the mathematical symbols used 
in the formulas. 

 
Overall Code Architecture
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The architecture of CAP88-PC was significantly modified in version 4.0 from Version 3. Many 
changes to the input dataset and output report file locations and file access methods were 
changed from version 3 in order to accommodate the stricter security policies built into the 
Windows Operating Systems after Windows XP Service Pack 3. The overall code 
architecture, with updates for version 4 in the callouts, is shown in the following diagram: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Version 4.1 has not midified the architectural changes introduced in Version 4.0. 

 
Environmental Transport
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CAP88-PC incorporates a modified version of the AIRDOS-EPA (Mo79) program to calculate 
environmental transport. Relevant portions of this document are reproduced here, as 
referenced. 

 
Plume Rise 

 
CAP88-PC calculates plume rise in the subroutine CONCEN using either Rupp's equation 
(Ru48) for momentum dominated plume rise, or Briggs' equations (Br69) for hot buoyant 
plumes (Mo79). CAP88-PC also accepts user-supplied values for plume rise for each Pasquill 
stability class. The plume rise, Δh, is added to the actual physical stack height, h [PH], to 
determine the effective stack height, H. The plume centerline is shifted from the physical 
height, h, to H as it moves downwind. The plume centerline remains at H unless 
gravitational settling of particulates produces a downward tilt, or until meteorological 
conditions change. 

 
Rupp's equation for momentum dominated plumes is: 

 
Equation 1 

 
 

Δh =  1.5 vd  
 μ 

 
where: 

 
 

Δh = plume rise [PR] 
v = effluent stack gas velocity (m/sec) [VEL] 
d = inside stack diameter (m) [DIA] 
μ = wind velocity (m/sec) [U] 

 
CAP88-PC models Briggs' buoyant plume rise for stability categories A, B, C, and D with: 

 
Equation 2 

 
 

 

Δh =  1.6 F 1/3 x2  /3 

 μ 
 
where: 

 
 

Δh = plume rise [PR] 
F = 3.7x10-5 QH 

QH = heat emission from stack gases (cal/sec) [QH] 
x = downwind distance (m) 
μ = wind speed (m/sec) [U] 

 
This equation is valid until the downwind distance is approximately ten times the stack 
height, 10h, where the plume levels off. For downwind distances greater than 10h, the 
equation used is: 

 
Equation 3 

 
Δh = 1.6 F1/3 (10h)2/3
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μ 
 
Equation (2) is also used to a distance of X = 2.4 μS-1/2  for stable categories E, F, and G, 
beyond which the plume is assumed to level off. For higher values of x, the stability 
parameter, S, is used in the equation: 

 
Equation 4 

 
Δh = 2.9(F/μS)1/3 

 
in which: 

 
Equation 5 

 
 

S = (g/Ta)(dTa/dz+Γ) 
g = gravitational acceleration (m/sec2 ) 
T = air temperature (o K) [TEMPERATURE] 
dTa/dz = vertical temperature gradient (o K/m) [TG] 
z = vertical distance above stack (m) 
Γ = adiabatic lapse rate of atmosphere (0.0098o K/m) 

 
The value of the vertical temperature gradient, dTa/dz, is positive for stable categories. In 
CAP88-PC, dTa/dz values are: 

 
7.280E-02 o K/m for Pasquill category E 
1.090E-01 o K/m for Pasquill category F 
1.455E-01 o K/m for Pasquill category G 

 
The true-average wind speed for each Pasquill stability category is used in CAP88-PC to 
estimate plume rise, as it is greater than the reciprocal-averaged wind speed, and produces 
a smaller, more conservative plume rise. This procedure does not risk underestimating the 
significant contribution of relatively calm periods to downwind nuclide concentrations which 
could result from direct use of a plume rise calculated for each separate wind-speed 
category. This procedure avoids calculating an infinite plume rise when wind speed is zero 
(during calms), since both momentum and buoyancy plume rise equations contain wind 
speed in the denominator (Mo79). 

 
CAP88-PC also accepts user-supplied plume rise values, for situations where actual 
measurements are available or the supplied equations are not appropriate. For example, 
plume rises of zero may be used to model local turbulence created by building wakes. 

 
Plume Dispersion 

 
Plume dispersion is modeled in the subroutine CONCEN with the Gaussian plume equation of 
Pasquill (Pa61, Mo79), as modified by Gifford: 

 
Equation 6 

 
 

Χ =        Q   exp[-1/2(y/σy )2 ]{exp[-1/2((z-H)/σz)2 ]+exp[-1/2((z+H)/σz )2 ]} 
 2 π σy σz μ  
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where: 
 
 

Χ = concentration in air (chi) at x meters downwind, y meters crosswind, and z 
meters above ground (Ci/m3) [ACON] 

Q = Release rate from stack (Ci/sec) [REL] 
μ = wind speed (m/sec) [U] 
σy = horizontal dispersion coefficient (m) 
σz = vertical dispersion coefficient (m) 
H = effective stack height (m) 
y = crosswind distance (m) 
z = vertical distance (m) 

 
The downwind distance x comes into Equation (6) through σy and σz, which are functions of 
x as well as the Pasquill atmospheric stability category applicable during emission from the 
stack. CAP88-PC converts Χ in Equation (6) and other plume dispersion equations from 
units of curies per cubic meter to units of picocuries per cubic centimeter. 

 
Annual-average meteorological data sets usually include frequencies for several wind-speed 
categories for each wind direction and Pasquill atmospheric stability category. CAP88-PC 
uses reciprocal-averaged wind speeds in the atmospheric dispersion equations, which 
permit a single calculation for each wind-speed category. Equation (6) is applied to ground- 
level concentrations in air at the plume centerline by setting y and z to zero, which results 
in: 

 
Equation 7 

 
 

Χ =       Q   exp[-1/2(H/σz )2 ] 
 π σy σz μ  

 
The average ground-level concentration in air over a sector of 22.5o can be approximated 
by the expression: 

 
Equation 8 

 
Χave = fΧ 

 
where f is the integral of the exponential expression: 

 
exp [-1/2(y/σy )2 ] 

 
in Equation (6) from a value of y equals zero to infinity divided by ys, the value of y at the 
edge of the 22.5o sector, which is the value of the downwind distance, x, multiplied by the 
tangent of half the sector angle. The expression is: 

 
Equation 9 
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The definite integral in the numerator of Equation (9) is evaluated as 
 

σy (π/2)1/2
 

 
Since ys = x tan (11.25o ), 

 
Equation 10 

 
 

f = 6.300836 σy   

 x 
 
The equation for sector-averaged ground level concentration in air is therefore: 

 
Equation 11 

 
 

Χ =            Q   exp[-1/2(H/σz )2 ] 
 0.15871 π x σz μ  

 
This method of sector-averaging compresses the plume within the bounds of each of the 
sixteen 22.5o sectors for unstable Pasquill atmospheric stability categories in which 
horizontal dispersion is great enough to extend significantly beyond the sector edges. It is 
not a precise method, however, because the integration over the y-axis, which is 
perpendicular to the downwind direction, x, involves increasing values for x as y is increased 
from zero to infinity. 

 
An average lid for the assessment area is provided as part of the input data. The lid is 
assumed not to affect the plume until x becomes equal to 2xL , where xL is the value of x for 
which σz = 0.47 times the height of the lid (Tu69). For values of x greater than 2xL , vertical 
dispersion is restricted and radionuclide concentration in air is assumed to be uniform from 
ground to lid. 

 
The average concentration between ground and lid, which is the ground-level concentration 
in air for values of x greater than 2xL, may be expressed by: 

 
Equation 12 

 

 
 
where Χ is taken from Equation (6) and L is lid height. The value of H in Equation (6) may 
be set at zero since Χave is not a function of the effective stack height. 

 
The resulting simplified expression may be evaluated for constant x and y values (σy and σz 

held constant) by using a definite integral similar to that in Equation (10): 
 

Equation 13 
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The result is: 
 

Equation 14 
 
 

Χave =          Q   exp(-y2 /2σy 2) 
 2.5066 σy L μ  

 
One obtains the sector-averaged concentration at ground level by replacing the exponential 
expression containing y by f in Equation (11): 

 
Equation 15 

 
Χave = Q/(0.397825 x L μ) 

 
It should be noted at this point that for values of the downwind distance greater than 2xL 

dispersion, as expressed in Equation (16), no longer can be said to be represented by the 
Pasquill equation. The model is simply a uniform distribution with a rectangle of dimensions 
LID and 2x tan (11.25o). 

 
Gravitational settling is handled by tilting the plume downward after it has leveled off at 
height H by subtracting Vg x/μ from H in the plume dispersion equations. For CAP88-PC Vg is 
set at the default value of zero and cannot be changed by the user. 

 
Dry Deposition 

 
Dry deposition is modeled in the subroutine CONCEN as being proportional to the ground- 
level concentration of the radionuclide (Mo79): 

 
Equation 16 

 
Rd = Vd Χ 

 
where: 

 
 

Rd = surface deposition rate (pCi/cm2 -sec) 
Vd = deposition velocity (cm/sec) [VD] 
Χ = ground-level concentration (chi) in air (pCi/cm3 ) [ACON] 

 
Although Vd has units of velocity, it is only a proportionality constant and is usually higher 
than the actual, measured velocity of radionuclides falling to the ground. The proportionality 
constant must include deposition from fallout interception by foliage, which subsequently 
falls to the ground and so adds to ground deposition. Defaults for deposition velocity used 
by CAP88-PC are 3.5E-2 m/sec for Iodine, 1.8E-3 m/sec for particulates and zero for gases. 

 
Precipitation Scavenging 

 
The deposition rate from precipitation scavenging (Mo79), which occurs when rain or snow 
removes particles from the plume, is modeled in CONCEN with: 

 
Equation 17
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Rs = ΦΧave L 
 
where: 

 
 

Rs = surface deposition rate (pCi/cm2 -sec) 
Φ = scavenging coefficient (sec-1 ) [SC] 
Χave = average concentration in plume up to lid height (pCi/cm3)[ACON] 
L = lid height (tropospheric mixing layer) (cm) [LID] 

 
The scavenging coefficient, Φ (in sec-1 ), is calculated in CAP88-PC by multiplying the 
rainfall rate, [RR] (in cm/yr), by 1E-7 yr/cm-sec. 

 
Plume Depletion 

 
Radionuclides are depleted from the plume by precipitation scavenging, dry deposition and 
radioactive decay. Depletion is accounted for by substituting a reduced release rate, Q1 , for 
the original release rate Q for each downwind distance x (Sl68). The ratio of the reduced 
release rate to the original is the depletion fraction. The overall depletion fraction used in 
CAP88-PC is the product of the depletion fractions for precipitation scavenging, dry 
deposition and radioactive decay. 

 
For precipitation scavenging the depletion fraction for each downwind distance (x) is: 

 
Equation 18 

 
 

 Q1    

= e-Φt 
Q  

 
where: 

 
 

Φ = scavenging coefficient (sec-1 ) [SC] 
t = time (sec) required for the plume to reach the downwind distance x 

 
The depletion fraction for dry deposition is derived by using Equation (6) with z set to zero 
for ground-level concentrations, and subtracting the quantity (Vg x)/U from H for a tilted 
plume (Va68, Mo79): 

 
Equation 19 

 

 
 
where: 

 
 

Vd = deposition velocity (m/sec) [VD] 
μ = wind speed (m/sec) [U] 
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σz = vertical dispersion coefficient (m) 
Vg = gravitational velocity (m/sec) [VG] 
H = effective stack height (m) 
x = downwind distance (m) 

 
The integral expression must be evaluated numerically. Values for the vertical dispersion 
coefficient σz are expressed as functions of x in the form xD/F where D and F are constants 
with different values for each Pasquill atmospheric stability category, to facilitate 
integrations over x. 

 
Values for the depletion fraction for cases where Vg is zero are obtained from the subroutine 
QY in CAP-88. Subroutine QY obtains depletion fractions for the conditions Vd = 0.01 m/sec 
and μ = 1 m/sec for each Pasquill stability category from the data file REFA.DAT. This file 
contains values for release heights (meters) of: 

 
1, 1.5, 2, 3, 4, 5, 6, 7, 8, 9, 10, 12.5, 15, 17.5, 20, 25, 30, 35, 40, 50, 60, 70, 80, 90, 100, 
120, 140, 160, 180, 200, 240, 260, 300 and 400. 

 
and for downwind distances (meters) of: 

 
35, 65, 100, 150, 200, 300, 400, 500, 650, 800, 1,000, 1,500, 2,000, 4,000, 7,000, 
10,000, 25,000, 60,000, 90,000, and 200,000. 

 
The stored depletion fractions were calculated numerically with a Simpson's rule routine. QY 
uses a linear interpolation to produce a fraction for the required downwind value, release 
height and Pasquill category for Vd = 0.01 m/sec and μ = 1 m/sec. The value is then 
converted to the appropriate value for the actual deposition velocity and wind speed by use 
of the equation: 

 
Equation 20 

 
(Q1 /Q)2 = (Q1 /Q)1 

100 Vd/μ
 

 
in which subscript 2 refers to the desired value and subscript 1 refers to the value for Vd = 
0.01 m/sec and μ = 1 m/sec. 

 

 
For downwind distances greater than 2xL where Equation 15 applies to the ground-level 
concentrations in air, the depletion is modeled with (Mo79): 

 
Equation 21 

 

 
 
Which shows the reduced release rates at distances x and 2xL , respectively. 

The depletion fraction for radioactive decay is: 

Equation 22
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where: 

 
 

λr = effective decay constant in plume [ANLAM] 
t = time required for plume travel 

 
The decay constant used is referred to as the "effective decay constant" since it is not the 
true radiological decay constant in all cases. For example, if a radionuclide is a short-lived 
decay product in equilibrium with a longer-lived parent, the effective decay constant would 
be equal to the true radiological decay constant of the parent. 

 
The atmospheric dispersion equations use the reciprocal-averaged wind speed, but neither 
this value nor the true average wind speed can adequately be used to calculate reduced 
release rates to account for radiological decay and scavenging losses because averaging of 
exponential terms is required. CAP88-PC uses an approximate method of calculation for this 
purpose, which establishes three wind speeds (1 m/sec, the average wind speed, and 6 
m/sec) to simulate the actual wind-speed spectrum for each specific wind direction and 
Pasquill category. The wind speeds 1 and 6 m/sec were chosen because they approximate 
the upper and lower bounds in most meteorological data sets. 

 
If f1, f2 and f3 are designated as the time fractions for the three wind speeds, then: 

 

 
 
and 

f1 + (μa f2 ) + 6f3 = μ, 
f1 + (f2 /μa) + f3 /6 = 1/μr 

 
f1 + f2 + f3 = 1

 
where: 

 
 

μa = Arithmetic-average wind speed [UDAV] 
μr = Reciprocal-average wind speed [UDCAT] 

 
Solving the three simultaneous equations yields: 

 
f1 = 1 - f2 - f3 

 

f2 =  (7/6) - (μa/6) - (1/μr)  
 (7/6) - (μa/6) - (1/μa) 

 

f3 = (μa  -1)(1 - f2  )  
 5 

 
The depletion fraction to account for radioactive decay is then approximated by: 

 
f1 exp(-λrx) + f2 exp[-λr(x/μa)] + f3 exp[-λr(x/6)] 

 
where: 

 

 
λr = effective decay constant in plume (sec-1 ) [ANLAM] 
μa = Arithmetic-average wind speed [UDAV] 
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x  = downwind distance (m) 
 
For precipitation scavenging losses, the depletion fraction is: 

 
f1 exp(-Φx) + f2 exp[-Φ(x/μa)] + f3 exp[-Φ(x/6)] 

 
where Φ is the scavenging coefficient (sec-1 ). 

 
The overall depletion fraction is calculated by multiplying the depletion fraction for dry 
deposition by the fraction for radioactive decay and precipitation scavenging. 

 
Dispersion Coefficients 

 
Horizontal and vertical dispersion coefficients (σy and σz ) used for dispersion calculation in 
CONCEN and for depletion fraction determination in QY are taken from recommendations by 
G.A. Briggs of the Atmospheric Turbulence and Diffusion Laboratory at Oak Ridge, 
Tennessee (Mo79, Gi76). The coefficients are different functions of the downwind distance x 
for each Pasquill stability category for open-country conditions, as shown: 

 
Pasquill 
category 
A 

σy 

(m) 
0.22 x 

σz 

(m) 
0.20 x 

 (1+0.0001x)-1/2  
B 0.16 x 

(1+0.0001x)-1/2 

0.12 x 

C 0.11 x 
(1+0.0001x)-1/2 

0.08 x 
(1+0.0002x)-1/2 

D 0.08 x 
(1+0.0001x)-1/2 

0.06 x 
(1+0.0015x)-1/2 

E 0.06 x 
(1+0.0001x)-1/2 

0.03 x 
(1+0.0003x)-1 

F 0.04 x 
(1+0.0001x)-1/2 

0.016 x 
(1+0.0003x)-1 

G                calculated by subtracting half the 
difference between values for categories E 
and F from the value for category F. 

 
where: 

 
x = downwind distance 

 
CAP88-PC uses the functions in the form of 

 
σy = xA /C 
σz = xD /F 

 
to facilitate integrations over x. Values for A, C, D, and F for each stability category and 
downwind distance are stored in a data statement. 

 
Area Sources
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Uniform area sources are modeled in CAP88-PC using a method described by Mills and 
Reeves, as modified by Christopher Nelson, EPA, and implemented by Culkowski and 
Patterson (Mo79). The method transforms the original area source into an annular segment 
with the same area. The transformation is dependent on the distance between the centroid 
of the area source and the receptor. At large distances (where the distance/diameter ratio is 
2.5), the area source is modeled as a point source; at close distances it becomes a circular 
source centered at the receptor. A point source model is also used if the area source is 10 
meters in diameter or less. 

 
The principle of reciprocity is used to calculate the effective chi/Q. The problem is equivalent 
to interchanging source and receptor and calculating the mean chi/Q from a point source to 
one or more sector segments according to the angular width of the transformed source. The 
mean value of chi/Q for each sector segment is estimated by calculating chi/Q at the 
distance which would provide the exact value of the mean if the variation in chi/Q were 
proportional to r-1.5 for distances from the point source to location within the sector 
segment. The chi/Q for the entire transformed source is the sum of the chi/Q values for 
each sector weighted by the portion of the total annular source contained in that sector. 

 
Carbon-14 and Tritium 

 
Special consideration is given to the radionuclides hydrogen-3 (tritium), carbon-14, and 
radon-222. The specific activity of tritium in air is calculated based on the input absolute 
humidity, which has a default value of 8 g/m3. The specific activity of atmospheric carbon- 
14 is calculated for a carbon dioxide concentration of 330 ppm by volume. Concentrations of 
these nuclides in vegetation are calculated on the assumption that the water and carbon 
content in vegetation are from the atmosphere and have the same specific activity as in the 
atmosphere. Drinking water is assumed to have one percent (1%) the concentration of air 
moisture. The ingestion dose includes a contribution from this assumed tritium 
concentration when tritium is included as one of the modeled nuclides in the case. The new 
dose factors in CAP88-PC Version 4 include many chemical forms for these special isotopes 
that were not available in previous versions (see the radionuclide list table for chemical 
forms). The user should examine which of the chemical forms is most applicable to their 
model case and select accordingly. 

 
Rn-222 Working Levels 

 
The radon decay product concentration (in working level units) is estimated using an 
equilibrium fraction that varies as a function of travel time, assuming a wind speed of 3.5 
meters/second, with a final equilibrium fraction of 0.7. 

 
Equilibrium fractions for radon decay products are calculated as a function of downwind 
distance, starting at 0.267 at 150 meters and reaching a final equilibrium fraction of 0.698 
at 19,551 meters. Equilibrium fractions for specific distances are calculated by linear 
interpolation, using this table: 

 
 

Distance 
(meters) 

Equilibirum 
Fraction 

150 .267 
200 .273 
250 .276 
300 .278 
400 .284 
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500 .289 
600 .293 
800 .302 
1000 .311 
1500 .331 
2000 .349 
2500 .366 
3000 .382 
4000 .414 
5000 .443 
6000 .471 
8000 .522 
10000 .566 
15000 .650 
19551 .698 

 
Sector Air Concentrations 

 
Air concentrations in each sector are calculated using the CAP88-PC Version 4 numerical 
solver to solve the serial radioactive decay equations for chains up to 30 isotopes in length 
at each sector. The equations solved include chain branching coefficients as defined by the 
chain decay data contained in the Oak Ridge National Laboratory DCFPAK Version 2.2. The 
initial values in the chain are the dispersed release rates for the isotopes specified in the 
release list. The dispersed concentrations of the released isotopes as calculated by the 
Gaussian Plume equations are used as the time zero concentration for each sector. Decay 
chain isotopic air concentrations for each sector are calculated using the Pasquill category 
averaged travel times and the midpoint distance for the sector to generate the decay time. 
The isotopic air concentrations generated for each sector form the list of source isotopes for 
the ground deposition rates used in the sector ground surface concentration calculation. 

 
Sector Ground Surface Concentrations 

 
Ground surface and soil concentrations are calculated for those nuclides subject to 
deposition due to dry deposition and precipitation scavenging. The deposition accumulation 
time, [TSUBB], is user selectable. The default value of 100 years is the value required to be 
used for NESHAPS compliance runs. This value determines the length of time that isotopes 
accumulate in the soil based upon continuous deposition, decay, and removal. The isotopic 
profile in the soil at the end of the buildup period is the one used as input to the dose and 
risk calculations. 

 
Ingrowth from a parent radionuclide is calculated using a numerical solution to the coupled 
set of differential equations describing radionuclide ingrowth in the presence of a constant 
deposition rate and a constant removal rate of 2 percent per year. The deposition rate for 
each isotope is calculated from the air concentration of that isotope in the sector of interest 
times the scavenging rate for each isotope in the air. Ingrowth and decay are calculated 
using the decay chain data from the Oak Ridge National Laboratory DCFPAK Version 2.2 
package. All chain decays include branching. Sectors are assumed to have a zero ground 
surface concentration at time zero. 

 
Ingrowth of progeny chains up to 30 isotopes in length can be solved by the CAP88-PC 
Version 4 solver code. The solver code implemented in CAP88-PC Version 4 is the DLSODE
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package from Lawrence Livermore National Lab. DLSODE solves the initial-value problem for 
stiff or nonstiff systems of first-order Ordinary Differential Equations, dy/dt = f(t,y). 

 
Dose and Risk Estimates 

 
CAP88-PC uses a database of dose and risk factors provided in Federal Guidance Report 13 
(EPA99) for estimating dose and risk as implemented in the DCFPAK Version 2.2 model. 
Relevant portions of these documents are reproduced here, as referenced. 

 
Dose and risk conversion factors include the effective dose equivalent calculated according 
to the methods in ICRP Publication Number 72 (ICRP72). CAP88-PC Version 4 now 
implements the FGR 13 age-dependent dose and risk factors, where previous version of 
CAP88-PC only used adult dose and risk factors. The risk factors used are those for lifetime 
fatal cancer risk (mortality) per FGR 13. Dose and risk factors for the pathways of ingestion 
and inhalation intake, ground level air immersion and ground surface irradiation are used in 
order to remain consistent with versions 1, 2, and 3 of CAP88-PC. Factors are further 
broken down by particle size [SIZE], clearance category [FMSTYPE], chemical form 
[CHEMFORM], and gut-to-blood [GI_ING and GI_INH] transfer factors. These factors are 
stored in a series of data files for use by the program. The CAP88-PC Version 4 UI reads the 
dose and risk factor data for each organ or compartment and builds the appropriate factor 
using the methodology in the DFCPAK Version 2.2 model. 

 
For assessments where Rn-222 decay products are not considered, estimates of dose and 
risk are made by combining the inhalation and ingestion intake rates, air and ground 
surface concentrations with the appropriate dose and risk conversion factors. CAP88-PC lists 
the dose and risk to the maximum individual and the collective population. CAP88-PC 
calculates dose to the 25 internal organs modeled in DCFPAK Version 2.2, in addition to a 
26th “organ”, the 50 year effective dose equivalent. Risks are estimated for the 15 cancer 
sites modeled in DCFPAK Version 2.2. Doses and risks can be further tabulated as a function 
of radionuclide, pathway, location and organ. 

 
For assessments of Rn-222 decay products, CAP88-PC calculates working levels, not 
concentrations of specific radionuclides. A working level [WLEVEL] is defined as any 
combination of short-lived radon decay products in 1 liter of air that will result in the 
ultimate emission of 1.3 x 105 MeV of alpha particle energy. CAP88-PC calculates risk, but 
not dose, from the working level calculations. Risk to the maximum individual and the 
collective population are tabulated. The radon methods have not been modified in CAP88-pC 
Version 4 from those of previous versions. 

 
For each assessment, CAP88-PC tabulates the frequency distribution of risk, that is, the 
number of people at various levels of risk (lifetime risk). The risk categories are divided into 
powers of ten, from 1 in ten to one in a million. The number of health effects is also 
tabulated for each risk category. 

 
Air Immersion 

 
Individual dose is calculated for air immersion with the general equation: 

 
 

 Eij(k) DFijl   Kj P(k)  
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where: 
 
 

Eij(k) = exposure rate, person-pCi/cm3 [EXPP] 
DFijl = Dose rate factor, mrem/nCi-yr/m3 [DOSE] 
P(k) = number of exposed people [POP] 
Kj = 0.001 nCi/pCi x 1,000,000 cm3/m3 (proportionality factor) [FAC] 

 
Risk is calculated similarly, by substituting the risk conversion factor, RFijl [RISK], for DFijl 

[DOSE]. The risk conversion factor is in units of risk/nCi-yr/m3 . 
 
Surface Exposure 

 
Individual dose is calculated for ground surface exposure with the general equation: 

 
 

 Eij(k) DFijl   Kj P(k)  
 
where: 

 
 

Eij(k) = exposure rate, person-pCi/cm3 [EXPP] 
DFijl = Dose rate factor, mrem/nCi-yr/m3 [DOSE] 
P(k) = number of exposed people [POP] 
Kj = 0.001 nCi/pCi x 10,000 cm3/m3 (proportionality factor) [FAC] 

 
Risk is calculated by substituting the risk conversion factor, RFijl [RISK], for DFijl [DOSE]. 
The risk conversion factor is in units of risk/nCi-yr/m2 . 

 
Ingestion and Inhalation 

 
Individual dose is calculated for the ingestion and inhalation exposure pathway with the 
general equation: 

 
 

 Eij(k) DFijl   Kj P(k)  
 
where: 

 
 

Eij(k) = exposure rate, person-pCi/cm3 [EXPP] 
DFijl = Dose rate factor, mrem/nCi-yr/m3 [DOSE] 
P(k) = number of exposed people [POP] 
Kj = 0.001 nCi/pCi x 1,000,000 cm3/m3 (proportionality factor) [FAC] 

 
Risk is calculated by substituting the risk conversion factor, RISK (risk/nCi), for DOSE. 

 
Maximally-Exposed Individual 

 
Doses for the maximally-exposed individual in population runs are estimated by CAP88-PC 
for the location, or sector-segment in the radial assessment grid, of highest risk where at 
least one individual actually resides. The effective dose equivalent for the maximally-
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Alabama 1.52E-001 7.02E-003 4.16E-003 
Alaska 0.00E+000 0.00E+000 0.00E+000 
Arkansas 1.27E-001 5.90E-003 1.46E-003 
Arizona 3.73E-002 2.80E-003 2.90E-003 
California 8.81E-002 2.85E-002 1.18E-002 
Colorado 1.13E-001 3.50E-003 1.39E-002 
Connecticut 3.60E-002 2.50E-003 7.93E-003 
Wash. D.C. 0.00E+000 0.00E+000 0.00E+000 
Delaware 6.48E-002 2.72E-002 5.85E-002 
Florida 1.28E-001 1.37E-002 6.92E-003 
Georgia 1.43E-001 8.63E-003 2.17E-003 
Hawaii 0.00E+000 0.00E+000 0.00E+000 
Idaho 7.19E-002 8.56E-003 7.15E-002 
Illinois 3.33E-001 2.16E-002 2.80E-002 
Indiana 3.34E-001 2.80E-002 2.72E-002 
Iowa 7.40E-001 3.14E-002 2.43E-002 
Kansas 2.90E-001 8.00E-003 5.97E-002 
Kentucky 2.65E-001 2.57E-002 3.98E-003 
Louisiana 1.08E-001 9.62E-003 4.35E-002 
Maine 7.65E-003 8.07E-003 5.97E-002 
Maryland 1.09E-001 6.11E-002 1.11E-002 
Massachusetts 2.90E-002 3.13E-002 4.96E-003 
Michigan 7.90E-002 3.51E-002 1.70E-002 
Minnesota 1.85E+000 4.88E-002 3.05E-002 
Mississippi 1.75E-001 8.70E-003 1.07E-003 
Missouri 3.43E-001 1.89E-002 8.14E-003 
Montana 7.29E-002 9.27E-004 8.78E-003 
Nebraska 3.50E-001 8.78E-003 2.39E-002 
Nevada 1.84E-002 5.65E-004 8.92E-003 
New Hampshire 1.40E-002 1.58E-002 6.69E-002 
New Jersey 4.25E-002 3.29E-002 1.82E-002 
New Mexico 4.13E-002 1.14E-003 1.38E-003 
New York 5.83E-002 8.56E-002 1.88E-002 
 

exposed individual is tabulated in mrem/yr for a 50 year exposure. Risk is estimated as total 
lifetime riske. 

 
Collective Population 

 
Collective population dose and risk are found by summing, for all sector segments, the 
intake and exposure rates multiplied by the appropriate dose or risk conversion factors 
(ORNL5692). Collective population dose is reported by person-Rem/yr (not millirem), and 
collective risk is reported in deaths/yr. Note that collective risk is reported as annual risk, 
while maximally-exposed individual risk is reported as lifetime risk. 

 
State Agricultural Productivies 

 
The following values are Beef Cattle Densities, Milk Cattle Densities, and Vegetable Crop 
Food Fractions by state. 

 
State               Beef          Milk          Vegetable
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North Carolina 1.02E-001 1.26E-002 6.32E-003 
North Dakota 1.18E-001 6.25E-003 6.29E-002 
Ohio 2.03E-001 4.56E-002 1.70E-002 
Oklahoma 2.68E-001 7.13E-003 2.800E-02 
Oregon 4.56E-002 4.53E-003 1.590E-02 
Pennsylvania 9.63E-002 6.46E-002 1.320E-02 
Rhode Island 2.50E-002 2.30E-002 4.540E-02 
South Carolina 8.87E-002 7.02E-003 1.84E-003 
South Dakota 2.32E-001 8.85E-003 1.20E-002 
Tennessee 2.11E-001 2.00E-003 2.72E-003 
Texas 1.90E-001 5.30E-003 5.77E-003 
Utah 2.84E-002 4.46E-003 1.83E-003 
Vermont 4.71E-002 8.88E-002 1.08E-003 
Virginia 1.31E-001 1.84E-002 8.700E-03 
Washington 5.62E-002 1.500E-02 5.200E-02 
West Virginia 6.23E-002 6.00E-003 1.160E-03 
Wisconsin 1.81E-001 1.43E-001 1.789E-02 
Wyoming 5.12E-002 5.79E-004 1.590E-03 

 
Differences From Mainframe Versions of AIRDOS-EPA/DARTAB 

 
There are differences between CAP88-PC and earlier versions of AIRDOS, PREPAR and 
DARTAB. CAP88-PC is optimized for doing population assessments. Population arrays must 
always be supplied to the program as a file, using the same format as the mainframe 
version of CAP88. Sample population files are supplied with CAP88-PC, the user may modify 
the supplied files to reflect their own population distributions. Population files for the 
mainframe version of CAP88 may be downloaded in ASCII format and used with CAP88-PC. 
CAP88-PC is programmed to use the distances in the population array to determine the 
distances used to calculate concentrations, to eliminate human error. CAP88-PC only uses 
circular grids; square grids are not an option. Direct user input of concentrations is also not 
an option. Agricultural arrays are generated automatically, as a function of state-specific 
productivity data, requiring the user to supply only the State abbreviation or agricultural 
productivity values. 

 
Note that input files generated with previous versions of CAP88-PC, or the mainframe 
version, will not run unaltered in the current CAP88-PC version. 

 
CAP88-PC is also modified to perform either "Radon-only" or "Non-Radon" runs, to conform 
to the format of the 1988 Clean Air Act NESHAPS Rulemaking. "Radon-only" assessments, 
which only have Rn-222 in the source term, automatically include working level 
calculations; any other source term ignores working levels. Synopsis reports customized to 
both formats are automatically generated. 

 
Organs and weighting factors are modified to follow the ICRP-72 Effective Dose Equivalent 
calculation, which eliminates flexibility on specifying organs and weighting factors. The 
calculation of deposition velocity and the default scavenging coefficient is also modified to 
incorporate current EPA policy. 

 
Incorporation of FGR-13 Dose and Risk Factors
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CAP88-PC Version 4.1 incorporates the dose and risk factors from Federal Guidance Report 
13 (FGR-13), as received from Oak Ridge National Laboratory via the DCFPAK Version 3.0 
software package. Using the DCFPAK 3.0 dataset has increased the supported number of 
isotopes to 1252 from 825 in version 3 and 256 in version 2. It is important to note that the 
1252 isotope number is those with external dose coefficients. The number of isotopes 
having internal dose coefficients in Version 4.1 is 888. Version 4.1 flags isotopes in the input 
that have external but not internal dose coefficients. 

 
Dose and risk coefficents are provided for external ground surface exposure, external 
immersion, internal ingestion, and internal inhalation. Internal dose and risk coefficients are 
provided for six age groups, infant (100 days), 1 year old, 5 year old, 10 year old, 15 year 
old, and adult. 

 
Organs and Weighting Factors 

 
The FGR 13 model as implemented in CAP88-PC Version 4.1 includes wieght factors and 
committed equivalent dose coefficents for 25 organs. The DCFPAK 3.02 data also include a 
‘26th organ’, the effective dose. CAP88-PC Version 4.1 uses the 25 organ data to calculate 
organ committed equivalent dose and the 26th organ data to calculate total effective dose. 
The list of organs contained in Version 4.1 is: 

 
 

Adrenals UB_Wall Bone_Sur Brain 
Breasts St_Wall SI_Wall ULI_Wall 
LLI_Wall Kidneys Liver Muscle 
Ovaries Pancreas R_Marrow Skin 
Spleen Testes Thymus Thyroid 
GB_Wall Ht_Wall Uterus ET_Reg 
Lung_66 Effecti   

 
UB = Urinary Bladder 

 
St = Stomach 

 
SI = Small Intestine 

 
ULI = Upper Large Intestine 

LLI = Lower large Intestine 

R_Marrow = Red Bone Marrow 

GB = Gall Bladder 

Ht = Heart 
 

ET = Extra-thoracic 
 

Changing the organ list or the weighting factors will invalidate the results. 
 

Cancer Risk Sites
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The FGR 13 data in CAP88PC Version 4 includes cancer morbidity and mortality risk factors 
for 14 cancer induction sites, with the total risk listed as the 15th site. CAP88PC Version 4.1 
only outputs results for cancer mortality risk, not cancer morbidity risk. This is done to 
retain consistency with previous versions of the CAP88 model. The cancer sites included in 
CAP88PC Version 4.1 are: 

 
 

Esophagus Stomach Colon Liver Lung 
Bone Skin Breast Ovaries Bladder 
Kidneys Thyroid Leukemia Residual Total 

 
As with the organ data, changing the cancer site information will invalidate the results. 

 
Build-up Factors Calculated for the Specific Case 

 
Starting with Version 3, CAP88-PC eliminated the old build-up factor methodology using 
pre-calculated factors for a limited number of decay chains. The greatly expanded isotope 
list contained in the FGR-13 data did not support the use of the old pre-calculated build-up 
factors. The solution method in Version 3 included a number of approximations to speed up 
the build-up calculation. Version 4 greatly improved the buildup and decay calculations by 
implementing solution that calculates the decay and ground surface concentrations as a 
function of time by solving the ingrowth + deposition equations using a numerical solver. 

 
Selectable Progeny Chain Length 

 
CAP88-PC version 4.1 permits the user to select the length of the progeny chain for which 
dose and risk will be calculated. Versions of CAP88-PC before Version 3 limited the decay 
chain to a maximum of five isotopes. The selectable chain length permits analyses to 
include up to the entire decay chain modeled in FGR-13. The default length is all isotopes. 

 
NCRP-123 Elemental Transfer Factors 

 
The plant and food chain transfer factors for each element are the factors found in 
Publication 123 of the National Council on Radiation Protection. The old transfer factors used 
through version 2.1 did not include all the elements that are in the FGR-13 dataset. 

 
Population Arrays 

 
Population arrays must be entered only as a file. In the 1985 CAAC version of 
AIRDOSEPA/DARTAB, population arrays could be entered as instream data in PREPAR. 
Population files for the mainframe version of CAP88 may be downloaded in ASCII format 
and used with CAP88-PC. Sample population files are supplied with CAP88-PC, the user may 
modify the supplied files to reflect their own population distributions. The distances at the 
top of the population file are used by CAP88-PC to determine the distances used in the 
assessment. This was programmed to eliminate errors caused by mismatching the distances 
used to calculate concentrations with the distances used to generate the population array. 
Distances used for calculating concentrations are now automatically set in CAP88-PC so as 
to calculate concentrations for the midpoint of each sector. 

 
Distances
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In population assessments, distances for calculating concentrations (IDIST) are calculated 
automatically as a function of the distances in the population array file. CAP88-PC is written 
to only allow user assignments of IDIST for individual assessments. 

 
Agricultural Arrays 

 
Arrays of milk cattle, beef cattle and agricultural crop area are automatically generated by 
the CAP88-PC; the user is not required to supply the arrays. The arrays are generated to 
match the distances used in the population arrays supplied to the code, and use State- 
specific agricultural productivity values. The state name (standard two letter abbreviation) 
must be provided to the variable STATE. Users are given the option to override the default 
agricultural productivity values. 

 
Radon-222 Assessments 

 
Assessments for Radon-222 automatically include Working Level calculations. When the only 
radionuclide entered is Rn-222, CAP88-PC assumes the run is a ‘Radon Only’ run; in this 
case the code generates total effective dose and mortality risk resulting from the Working 
Level calculations and omits the organ calculations. If Rn-222 is included as part of a case 
that has multiple radioisotopes in the release source, then organ dose and risk calculations 
are performed for the nuclides in the list, and the Working Level calculations of total 
effective dose and mortality risk are also performed and reported. Working Level 
calculations are only omitted if Rn-222 is not included in the isotope list. 

 
Square Grids 

 
Option 2 in earlier versions of AIRDOS-EPA allowed users to choose either a square (0) or 
circular grid (1). Since CAP88-PC requires a circular grid for population assessments, this 
option is not available. 

 
Scavenging Coefficient 

 
The subroutine SETSC (from PREPAR) is no longer used. The default scavenging coefficient 
(SC) is now calculated as a function of rainfall rate (RR). The formula used is: SC = RR * 
1E-7. Users are given the option of overriding the default value but doing so will invalidate 
the use of the case for any NESHAPS compliance demonstration. 

 
Direct Input of Concentrations 

 
In all versions of CAP88-PC the user may not supply concentrations as input. The subroutine 
DIRECT contained in the mainframe version has been removed. 

 
Deposition Velocity 

 
The mainframe subroutine SETVD is no longer used to calculate deposition velocity (VD). In 
all version of CAP88-PC VD is set as follows: 

 
 

Class VD (m/sec) 
Iodine 3.5e-2 
Particulate 1.8e-3 
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Gas          0 
 
Unlike previous versions of CAP88-PC, CAP88-PC since Version 4 has the ability to use 
isotope-specific deposition velocities. This data has not yet been implemented. 

 
Equilibrium Fractions 

 
CAP88-PC has the capability to vary equilibrium fractions; previously they were set to a 
constant of 0.7. The new method varies the equilibrium fractions depending on the distance 
from the source. Linear interpolation is used to determine the equilibrium fractions for 
distances that do not match the set distances given. The equation is as follows: 

 
EFY = EFX + ((EFZ - EFX) * ((Y - X) / (Z - X))) 

Where you have X < Y < Z 

X and Z are the set distances given and Y is the user given distance (between X and Z). The 
new method finds the equilibrium fraction for EFX, and EFZ is the value returned by the 
subroutine SET_EQUIL_FRACTIONS corresponding to the set distances. 

 
DOSMIC Subroutine 

 
DOSMIC was modified to print only Working Levels. Working Levels are only output for RN- 
222. Checks are performed before DOSMIC is called to determine if Working Levels are 
needed. 

 
Water Arrays 

 
Arrays of water areas are not used in CAP88-PC 

 
NOMA fix 

 
CAP88-PC uses a slightly different approach in calculating NOMA, following discovery of a 
potential error in the 1985 CAAC version of AIRDOS-EPA. In the earlier version, this error 
caused multiple point sources to be treated as an area source if the nuclides emitted from 
each stack had identical characteristics. This may cause some differences with previous 
assessments. 

 
Wind Frequencies 

 
The GETWND routine has been modified to accept wind speeds greater than 10 m/sec. 
Earlier versions would only accept wind speeds less than 10 m/sec, and there was a 
problem with some facilities, which had high wind speeds, generating overflow errors in the 
wind speed arrays. In order to accommodate higher wind speeds, and remain compatible 
with existing wind data sets, precision limits force the calculations to truncate the last digit 
in the wind speed data. This may cause a slight variation in the determination of PERD, the 
wind frequency for each direction, caused by roundup error. This may cause a variation in 
concentrations as compared with earlier versions of PREPAR and AIRDOS. 
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Appendices 
 

STAR File Format 
 

This is a STability ARay (STAR) file. It shows the frequencies of occurrence that the wind is 
blowing FROMa particular direction, at a particular stability, at a particular speed. GETWIND 
converts the star array to a WIND file which shows wind blowing TOWARD (not FROM) 
particular directions. The frequencies are in x.xxxxx format, unspaced. The format is: 

 
Layout 

 
 

Column Value 
1 Blank 
2-4 Wind Direction 
5 Blank 
6 Stability Category 
7 Blank 
8 Start of Wind Speed Categories (knots) 
8-14 Wind Speeds 1-3 (knots) 
15-21 Wind Speeds 4-6 (knots) 
22-28 Wind Speeds 7-10 (knots) 
29-35 Wind Speeds 11-16 (knots) 
36-42 Wind Speeds 17-21 (knots) 
43-49 Wind Speeds > 21 (knots) 

 
Sample 

 
This is the included 94823.str file. 

 

N A 0.000000.000000.000000.000000.000000.00000 
NNE A 0.000000.000000.000000.000000.000000.00000 
NE A 0.000000.000000.000000.000000.000000.00000 

ENE A 0.000000.000000.000000.000000.000000.00000 
E A 0.000000.000000.000000.000000.000000.00000 

ESE A 0.000000.000000.000000.000000.000000.00000 
SE A 0.000000.000000.000000.000000.000000.00000 

SSE A 0.000000.000000.000000.000000.000000.00000 
S A 0.000000.000000.000000.000000.000000.00000 

SSW A 0.000000.000000.000000.000000.000000.00000 
SW A 0.000000.000000.000000.000000.000000.00000 

WSW A 0.000000.000000.000000.000000.000000.00000 
W A 0.000000.000000.000000.000000.000000.00000 

WNW A 0.000000.000000.000000.000000.000000.00000 
NW A 0.000000.000000.000000.000000.000000.00000 

NNW A 0.000000.000000.000000.000000.000000.00000 
N B 0.000000.000000.000000.000000.000000.00000 

NNE B 0.000000.000000.000000.000000.000000.00000 
NE B 0.000000.000000.000000.000000.000000.00000 

ENE B 0.000000.000000.000000.000000.000000.00000 
E B 0.000000.016670.000000.000000.000000.00000 

ESE B 0.000000.000000.000000.000000.000000.00000 
SE B 0.000000.008330.008330.000000.000000.00000 

SSE B 0.000000.000000.000000.000000.000000.00000 
S B 0.000000.000000.000000.000000.000000.00000 

SSW B 0.000000.000000.000000.000000.000000.00000 
SW B 0.000000.000000.000000.000000.000000.00000 



CAP88-PC 4.1 Documentation Page 90 of 103  

 

WSW B 0.000000.000000.000000.000000.000000.00000 
W B 0.000000.000000.000000.000000.000000.00000 

WNW B 0.000000.000000.000000.000000.000000.00000 
NW B 0.000000.000000.000000.000000.000000.00000 

NNW B 0.000000.000000.000000.000000.000000.00000 
N C 0.000000.000000.000000.000000.000000.00000 

NNE C 0.000000.000000.000000.000000.000000.00000 
NE C 0.000000.008330.000000.000000.000000.00000 

ENE C 0.000000.008330.008330.000000.000000.00000 
E C 0.000000.041670.058330.000000.000000.00000 

ESE C 0.000000.000000.000000.000000.000000.00000 
SE C 0.008330.000000.016670.000000.000000.00000 

SSE C 0.008330.000000.000000.000000.000000.00000 
S C 0.000000.000000.000000.000000.000000.00000 

SSW C 0.008330.000000.000000.000000.000000.00000 
SW C 0.000000.000000.000000.000000.000000.00000 

WSW C 0.000000.016670.000000.000000.000000.00000 
W C 0.000000.008330.008330.000000.000000.00000 

WNW C 0.008330.008330.000000.000000.000000.00000 
NW C 0.000000.008330.000000.000000.000000.00000 

NNW C 0.000000.008330.000000.000000.000000.00000 
N D 0.000000.000000.000000.000000.000000.00000 

NNE D 0.000000.000000.000000.000000.000000.00000 
NE D 0.000000.000000.000000.000000.000000.00000 

ENE D 0.000000.000000.008330.000000.000000.00000 
E D 0.000000.050000.075000.000000.000000.00000 

ESE D 0.000000.008330.000000.000000.000000.00000 
SE D 0.025000.000000.033330.000000.000000.00000 

SSE D 0.016670.000000.000000.000000.000000.00000 
S D 0.000000.000000.000000.000000.000000.00000 

SSW D 0.000000.000000.000000.000000.000000.00000 
SW D 0.000000.000000.000000.000000.000000.00000 

WSW D 0.000000.000000.000000.000000.000000.00000 
W D 0.008330.025000.016670.000000.000000.00000 

WNW D 0.000000.016670.025000.000000.000000.00000 
NW D 0.000000.008330.008330.000000.000000.00000 

NNW D 0.000000.008330.000000.000000.000000.00000 
N E 0.000000.000000.000000.000000.000000.00000 

NNE E 0.000000.000000.000000.000000.000000.00000 
NE E 0.000000.000000.000000.000000.000000.00000 

ENE E 0.000000.000000.000000.000000.000000.00000 
E E 0.000000.041670.000000.000000.000000.00000 

ESE E 0.008330.000000.000000.000000.000000.00000 
SE E 0.025000.000000.000000.000000.000000.00000 

SSE E 0.050000.000000.000000.000000.000000.00000 
S E 0.000000.000000.000000.000000.000000.00000 

SSW E 0.000000.000000.000000.000000.000000.00000 
SW E 0.008330.000000.000000.000000.000000.00000 

WSW E 0.000000.000000.000000.000000.000000.00000 
W E 0.008330.016670.000000.000000.000000.00000 

WNW E 0.000000.000000.000000.000000.000000.00000 
NW E 0.000000.008330.008330.000000.000000.00000 

NNW E 0.000000.000000.000000.000000.000000.00000 
N F 0.000000.000000.000000.000000.000000.00000 

NNE F 0.000000.000000.000000.000000.000000.00000 
NE F 0.000000.000000.000000.000000.000000.00000 

ENE F 0.000000.000000.000000.000000.000000.00000 
E F 0.000000.008330.000000.000000.000000.00000 

ESE F 0.008330.008330.000000.000000.000000.00000 
SE F 0.008330.000000.000000.000000.000000.00000 

SSE F 0.008330.000000.000000.000000.000000.00000 
S F 0.033330.000000.000000.000000.000000.00000 

SSW F 0.025000.008330.000000.000000.000000.00000 
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BDL1262 Hartford CT 55/1-64/12 
BDR0558 Bridgeport CT 65/1-69/12 
NHZ0180 Brunswick CT 60/1-69/12 
 

 

SW F 0.033330.000000.000000.000000.000000.00000 
WSW F 0.041670.008330.000000.000000.000000.00000 
W F 0.016670.000000.000000.000000.000000.00000 

WNW F 0.008330.008330.000000.000000.000000.00000 
NW F 0.000000.000000.000000.000000.000000.00000 

NNW F 0.000000.000000.000000.000000.000000.00000 

 
 
Weather Data Library 

 
ALABAMA 
Abbreviation City         State Year/Month Range 
HSV0544 Huntsville AL 60/1-64/12 

 
ARIZONA 
Abbreviation City      State Year/Month Range 
INW0314 Winslow AZ 49/1-54/12 
PNX0309 Phoenix AZ 55/1-64/12 

 
ARKANSAS 
Abbreviation City          State Year/Month Range 
LIT0516 Little Rock AR 55/1-64/12 
LIT0165 Little Rock AR 72/2-73/2 

 
CALIFORNIA 
Abbreviation City                State Year/Month Range 
BUR1051 Burbank CA 60/1-64/12 
LAX0304 Los Angeles CA 64/5-69/4 
LGB1052 Long Beach CA 60/1-64/12 
NZY0380 San Diego CA 67/1-71/12 
OAK0319 Oakland CA 60/1-64/12 
SAC0320 Sacramento CA 66/1-70/12 
SBA0313 Santa Barbara CA 60/1-64/12 
SNA1467 Santa Ana CA 72/1-76/12 
SUU0316 Fairfield/Travis CA 60/1-64/12 

 
COLORADO 
Abbreviation City                State Year/Month Range 
DEN0618 Denver CO 60/1-64/12 
DEN0952 Denver CO 70/1-74/12 
EEE1420 Eagle Co. CO 76/1-76/12 
GJT0476 Grand Junction CO 60/1-64/12 
PUB0564 Pueblo CO 66/1-70/12 

 
CONN 
Abbreviation City          State Year/Month Range
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ALO0729 Waterloo IA 60/1-64/12 
DSM0753 Des Moines IA 72/1-72/12 
 

DELAWARE 
Abbreviation City           State Year/Month Range 
ILG1058 Wilmington DE 60/1-64/12 

 
DISTRICT OF COLUMBIA 
Abbreviation City            State Year/Month Range 
DCA1047 Washington DC 68/1-73/12 

 
FLORIDA 
Abbreviation City                    State Year/Month Range 
MIA0979 Miami FL 70/1-74/12 
PBI0054 West Palm Beach FL 70/1-70/12 
TLH0663 Tallahassee FL 60/1-64/12 
TPA0662 Tampa FL 60/1-64/12 
TPA0915 Tampa FL 69/1-73/12 
MCO0838 Orlando FL 74/1-74/12 

 
GEORGIA 
Abbreviation City         State Year/Month Range 
AGS1018 Augusta GA 70/1-74/12 
AMB0771 Alma GA 54/1-58/12 
CSG0767 Columbus GA 69/1-73/12 

 
IDAHO 
Abbreviation City           State Year/Month Range 
BOI0653 Boise ID 60/1-64/12 
MLP1448 Mullan Pass ID 50/1-54/12 
PIH0359 Pocatello ID 58/1-62/12 

 
ILLINOIS 
Abbreviation City                          State Year/Month Range 
MDW0675 Chicago/Midway IL 73/1-73/12 
MLI0269 Moline/Quad City IL 67/1-71/12 
ORD0452 Chicago/OHare IL 65/1-69/12 
PIA0716 Peoria IL 65/1-69/12 
RAN0234 Rantoul/Chanute AFB IL 63/1-67/12 
SPI0415 Springfield IL 67/1-71/12 

 
INDIANA 
Abbreviation City            State Year/Month Range 
EVV0406 Evansville IN 60/1-64/12 
FWA1156 Ft. Wayne IN 60/1-64/12 
IND1080 Indianapolis IN 55/1-74/12 
SBN0257 South Bend IN 67/1-71/12 

 
IOWA 
Abbreviation City           State Year/Month Range
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KANSAS 
Abbreviation City                 State Year/Month Range 
FLV0561 Ft Leavenworth KS 62/1-70/12 
MKC1323 Kansas City KS 67/1-71/12 
TOP0534 Topeka KS 63/1-72/12 

 
KENTUCKY 
Abbreviation City         State Year/Month Range 
CVG0403 Covington KY 58/1-62/12 
CVG1916 Covington KY 70/1-74/12 
PAH0479 Paducah KY 60/1-64/12 

 
LOUISIANA 
Abbreviation City             State Year/Month Range 
BTR0169 Baton Rouge LA 72/1-72/12 
BTR0166 Baton Rouge LA 55/1-64/12 
NBG1379 New Orleans LA 67/1-71/12 

 
MARYLAND 
Abbreviation City                State Year/Month Range 
BAL1059 Baltimore MD 69/1-73/12 
FME1207 Ft Meade MD 60/1-64/12 
NHK1306 Patuxent River MD 75/1-75/12 

 
MASS 
Abbreviation City                State Year/Month Range 
BED0181 Bedford MA 63/1-67/12 
BOS0211 Boston/Logan MA 67/1-71/12 
CEF0182 Chicopee Falls MA 60/1-64/12 
NZW1144 So. Weymouth MA 70/1-74/12 

 
MICHIGAN 
Abbreviation City                     State Year/Month Range 
BTL1460 Battle Creek MI 50/1-54/12 
TVC0844 Traverse City MI 74/1-74/12 
MKG0251 Muskegon County MI 67/1-71/12 
YIP1061 Detroit MI 63/10-68/9 

 
MINNESOTA 
Abbreviation City                     State Year/Month Range 
MSP0267 Minneapolis/St. Pl MN 67/1-71/12 

 
MISSOURI 
Abbreviation City        State Year/Month Range 
COU0170 Columbia MO 64/1-68/12 
STL0603 St. Louis MO 60/1-64/12 

 
MISSISSIPPI 
Abbreviation City          State Year/Month Range
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CLT0682 Charlotte NC 69/1-73/12 
FBG0075 Ft Bragg NC 66/1-70/12 
HAT0392 Cape Hatteras NC 66/1-70/12 
INT0531 Winston Salem NC 60/1-64/12 
NKT0106 Cherry Pt NC 67/1-71/12 
 

 

BIX0538 Biloxi MS 60/1-64/12 
CGM0670 Columbus MS 66/1-70/12 
SGF0178 Springfield MS 66/1-70/12 
JAN1169 Jackson MS 55/1-64/12 

 
MONTANA 
Abbreviation City     State Year/Month Range 
BIL0331 Billings MT 67/1-71/12 
BTM0357 Butte MT 56/1-60/12 

 
NEBRASKA 
Abbreviation City                State Year/Month Range 
LNK1142 Lincoln NE 59/1-63/12 
OMA0991 Omaha/Eppley NB 55/1-64/12 

 
NEVADA 
Abbreviation City           State Year/Month Range 
UCC1026 Yucca Flats NV 61/12-64/11 

 
NEW JERSEY 
Abbreviation City         State Year/Month Range 
NEL0505 Lakehurst NJ 68/1-72/12 

 
NEW MEXICO 
Abbreviation City             State Year/Month Range 
ABQ0282 Albuquerque NM 60/1-64/12 
CNM1741 Carlsbad NM 50/1-54/12 
FMN0285 Farmington NM 63/5-68/4 
GNT1246 Grants NM 54/1-54/12 
SAF1184 Santa Fe NM 50/1-54/12 

 
NEW YORK 
Abbreviation City                        State Year/Month Range 
ALB0523 Albany NY 60/1-64/12 
BUF0741 Buffalo NY 73/1-73/12 
HPN0429 White Plain NY 49/1-53/12 
IAG0905 Niagra Falls NY 55/1-59/12 
LEA0189 New York/LaGuardia NY 65/1-70/12 
LEA0435 NY/Ft Totte NY 65/1-69/12 
ROC0598 Rochester NY 55/1-64/12 
SWF0185 Newburgh NY 65/1-69/12 

 
NORTH CAROLINA 
Abbreviation City                State Year/Month Range
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BNA0149 Nashville TN 66/1-70/12 
CHA0711 Chattanooga TN 68/1-73/12 
MEM0143 Memphis TN 67/1-71/12 
TRI1191 Bristol TN 74/1-74/12 
TYS1328 Knoxville TN 55/1-64/12 
 

 

ILM0104 Wilmington NC 66/1-70/12 
RDU0083 Raleigh NC 66/1-70/12 

 
NORTH DAKOTA 
Abbreviation City        State Year/Month Range 
DIK0509 Dickinson ND 60/1-64/12 

 
OHIO 
Abbreviation City         State Year/Month Range 
CLE1140 Cleveland OH 70/1-74/12 
CMH0243 Columbus OH 60/1-64/12 
DAY0404 Dayton OH 65/1-69/12 
DAY1502 Dayton OH 76/1-76/12 
IBG0745 Perry OH 49/1-49/12 
TOL0990 Toledo OH 60/1-64/12 

 
OREGON 
Abbreviation City      State Year/Month Range 
PDX0364 Portland OR 67/1-71/12 

 
PENNSYLVANIA 
Abbreviation City             State Year/Month Range 
AVP0499 Wilkes-Barre PA 60/1-64/12 
ERI0610 Erie PA 64/1-73/12 
HAR0631 Harrisburg PA 64/1-64/12 
RDG0184 Reading PA 49/1-49/12 

 
RHODE ISLAND 
Abbreviation City          State Year/Month Range 
PVD0560 Providence RI 68/1-72/12 

 
SOUTH CAROLINA 
Abbreviation City                    State Year/Month Range 
CAE1371 Columbia SC 56/1-75/12 
FLO0600 Florence/Gilbert SC 60/1-64/12 
GSP0528 Greenville/Sparta SC 68/1-72/12 
MYR1027 Myrtle Beach SC 66/1-70/12 

 
SOUTH DAKOTA 
Abbreviation City         State Year/Month Range 
RAP0336 Rapid City SD 67/1-71/12 

 
TENNESSEE 
Abbreviation City             State Year/Month Range



CAP88-PC 4.1 Documentation Page 96 of 103  

TEXAS 
Abbreviation City               State Year/Month Range 
AMA0621 Amarillo TX 55/1-64/12 
CRP1459 Corpus Christi TX 73/7-77/6 
SAT0064 San Antonio TX 60/1-64/12 

 
UTAH 
Abbreviation City               State Year/Month Range 
HV40302 Hanksville UT 49/1-54/12 
SLC1411 Salt Lake City UT 72/1-76/12 

 
VIRGINIA 
Abbreviation City             State Year/Month Range 
IAD0398 Wash/Dulles VA 66/1-70/12 
GVE0824 Gordonsville VA 56/1-60/12 
ROA0526 Roanoke VA 68/1-72/12 

 
WASHINGTON 
Abbreviation City           State Year/Month Range 
GEG0360 Spokane WA 67/1-71/12 
MWH0486 Moses Lake WA 61/1-65/12 
YKM0484 Yakima WA 50/1-54/12 

 
WEST VIRGINIA 
Abbreviation City           State Year/Month Range 
CRW0655 Charleston WV 68/1-73/12 
HTS0019 Huntington WV 67/1-71/12 

 
WISCONSIN 
Abbreviation City          State Year/Month Range 
EAU0715 Eau Claire WI 69/1-73/12 
ERB0776 Green Bay WI 64/1-73/12 

 
WYOMING 
Abbreviation City               State Year/Month Range 
CPR0335 Casper WY 67/1-71/12 
LND1100 Lander WY 70/1-74/12 
RWL1261 Rawlins WY 55/1-64/12 
RKS1588 Rocky Springs WY 71/1-75/12 

 
Radionuclide List 

 
This is the list of nuclides used by CAP88-PC Version 4.1 from the DCFPAK V3.02 data. 

Count: 1252 

Special Ingestion and Inhalation Chemical Forms in CAP88 Version 4.1



 

 

 
Element 

 

Special Ingestion Chemical 
Forms 

Special Inhalation Chemical 
Forms (including gases and 

vapors) 
Hydrogen Tritiated Water (HTO) 

Organically Bound Tritium 
Tritiated Water (HTO) 
Elemental Tritium (HT) 
Organically Bound Tritium 

Carbon  Carbon Monoxide (CO) 
Carbon Dioxide (CO2) 

Sulfur  Sulfur Dioxide (SO2) 
Carbon Disulfide (CS2) 

Nickel  Nickel Vapor 
Ruthenium  Ruthenium Vapor 
Tellurium  Tellurium Vapor 
Iodine  Iodine Vapor 

 Methyl Iodide (CH3I) 
Mercury Inorganic Inorganic 

Methyl Mercury Vapor 
Organic Organic 

Polonium Organic  
Inorganic  
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Nuclides in CAP88 Version 4.1 

 
 

 

Element Internal & External Dose 
Conversion Factors 

External Dose Conversion 
Factors Only 

Hydrogen H-3  
Helium   
Lithium   
Beryllium Be-7, Be-10  
Boron   
Carbon C-11, C-14 C-10 
Nitrogen N-13, N-16 
Oxygen O-14, O-15, O-19 
Fluorine F-18 F-17 
Neon Ne-19, Ne-24 
Sodium Na-22, Na-24  
Magnesium Mg-28 Mg-27 
Aluminum Al-26 Al-28, Al-29 
Silicon Si-31, Si-32  
Phosphorus P-32, P-33 P-30 
Sulfur S-35, S-38 S-37 
Chlorine Cl-34m, Cl-36, Cl-38, Cl-39 Cl-34, Cl-40 
Argon Ar-37, Ar-39, Ar-41, Ar-42, Ar-43, Ar-44 
Potassium K-40, K-42, K-43, K-44, K-45 K-38, K-46 
Calcium Ca-41, Ca-45, Ca-47 Ca-49 
Scandium Sc-43, Sc-44, Sc-44m, Sc-46, Sc-47, Sc-42m, Sc-50 

Sc-48, Sc-49 
Titanium Ti-44, Ti-45 Ti-51, Ti-52 
Vanadium V-47, V-48, V-49, V-50 V-52, V-53 
Chromium Cr-48, Cr-49, Cr-51 Cr-55, Cr-56 
Manganese Mn-51, Mn-52, Mn-52m, Mn-53, Mn-54, Mn-50m, Mn-57, Mn-58m 

Mn-56 
Iron Fe-52, Fe-55, Fe-59, Fe-60 Fe-53, Fe-53m, Fe-61, Fe-62 
Cobalt Co-55, Co-56, Co-57, Co-58, Co-58m, Co-54m, Co-62 

Co-60, Co-60m, Co-61, Co-62m 
Nickel Ni-56, Ni-57, Ni-59, Ni-63, Ni-65, Ni-66  
Copper Cu-60, Cu-61, Cu-64, Cu-67 Cu-57, Cu-59, Cu-62, Cu-66, Cu-69 
Zinc Zn-62, Zn-63, Zn-65, Zn-69, Zn-69m, Zn-60, Zn-61, Zn-71 

Zn-71m, Zn-72 
Gallium Ga-65, Ga-66, Ga-67, Ga-68, Ga-70, Ga-64, Ga-74 

Ga-72, Ga-73 
Germanium Ge-66, Ge-67, Ge-68, Ge-69, Ge-71,  

Ge-75, Ge-77, Ge-78  
Arsenic As-69, As-70, As-71, As-72, As-73, As- As-68, As-79 

74, As-76, As-77, As-78 
Selenium Se-70, Se-72, Se-73, Se-73m, Se-75, Se-71, Se-77m, Se-79m, Se-83m, Se-84 

Se-79, Se-81, Se-81m, Se-83 
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Element Internal & External Dose 
Conversion Factors 

External Dose Conversion 
Factors Only 

Bromine Br-74, Br-74m, Br-75, Br-76, Br-77, Br- Br-72, Br-73, Br-76m, Br-77m, Br-78, Br- 
82m, Br-84m, Br-85 80, Br-80m, Br-82, Br-83, Br-84 

Krypton Kr-74, Kr-75, Kr-76, Kr-77, Kr-79, Kr-81, 
Kr-81m, Kr-83m, Kr-85, Kr-85m, Kr-87, 
Kr-88, Kr-89 

Rubidium Rb-78, Rb-79, Rb-81, Rb-81m, Rb-82m, Rb-77, Rb-78m, Rb-80, Rb-82, Rb-86m, 
Rb-90, Rb-90m Rb-83, Rb-84, Rb-84m, Rb-86, Rb-87, 

Rb-88, Rb-89 
Strontium Sr-80, Sr-81, Sr-82, Sr-83, Sr-85, Sr- Sr-79, Sr-93, Sr-94 

85m, Sr-87m, Sr-89, Sr-90, Sr-91, Sr-92 
Yttrium Y-84m, Y-85, Y-85m, Y-86, Y-86m, Y- Y-81, Y-83, Y-83m, Y-89m 

87, Y-87m, Y-88, Y-90, Y-90m, Y-91, Y- 
91m, Y-92, Y-93, Y-94, Y-95 

Zirconium Zr-86, Zr-87, Zr-88, Zr-89, Zr-93, Zr-95, Zr-85, Zr-89m 
Zr-97 

Niobium Nb-88, Nb-89, Nb-89m, Nb-90, Nb-91, Nb-87, Nb-88m, Nb-94m, Nb-99, Nb- 
99m Nb-91m, Nb-92, Nb-92m, Nb-93m, Nb- 

94, Nb-95, Nb-95m, Nb-96, Nb-97, Nb- 
98m 

Molybdenum Mo-90, Mo-91, Mo-93, Mo-93m, Mo-99, Mo-89, Mo-91m 
Mo-101, Mo-102 

Technetium Tc-93, Tc-93m, Tc-94, Tc-94m, Tc-95, Tc-91, Tc-91m, Tc-92, Tc-102, Tc-102m, 
Tc-105 Tc-95m, Tc-96, Tc-96m, Tc-97, Tc-97m, 

Tc-98, Tc-99, Tc-99m, Tc-101, Tc-104 
Ruthenium Ru-94, Ru-95, Ru-97, Ru-103, Ru-105, Ru-92, Ru-107, Ru-108 

Ru-106 
Rhodium Rh-97, Rh-97m, Rh-99, Rh-99m, Rh- Rh-94, Rh-95, Rh-95m, Rh-96, Rh-96m, 

Rh-98, Rh-100m, Rh-104, Rh-104m, Rh- 
106, Rh-108, Rh-109 

100, Rh-101, Rh-101m, Rh-102, Rh- 
102m, Rh-103m, Rh-105, Rh-106m, Rh- 
107 

Palladium Pd-98, Pd-99, Pd-100, Pd-101, Pd-103, Pd-96, Pd-97, Pd-109m, Pd-114 
Pd-107, Pd-109, Pd-111, Pd-112 

Silver Ag-101, Ag-102, Ag-103, Ag-104, Ag- Ag-99, Ag-100m, Ag-102m, Ag-105m, 
Ag-108, Ag-109m, Ag-110, Ag-111m, 
Ag-113m, Ag-114, Ag-116, Ag-117 

104m, Ag-105, Ag-106, Ag-106m, Ag- 
108m, Ag-110m, Ag-111, Ag-112, Ag- 
113, Ag-115 

Cadmium Cd-104, Cd-105, Cd-107, Cd-109, Cd- Cd-101, Cd-102, Cd-103, Cd-119, Cd- 
119m 111m, Cd-113, Cd-113m, Cd-115, Cd- 

115m, Cd-117, Cd-117m, Cd-118 
Indium In-107, In-108, In-108m, In-109, In-110, In-103, In-105, In-106, In-106m, In- 

109m, In-111m, In-114, In-118, In-118m, 
In-119, In-121, In-121m 

In-110m, In-111, In-112, In-112m, In- 
113m, In-114m, In-115, In-115m, In- 
116m, In-117, In-117m, In-119m 

Tin Sn-108, Sn-109, Sn-110, Sn-111, Sn- Sn-106, Sn-125m, Sn-127m, Sn-129, 
Sn-130, Sn-130m 113, Sn-113m, Sn-117m, Sn-119m, Sn- 

121, Sn-121m, Sn-123, Sn-123m, Sn- 
125, Sn-126, Sn-127, Sn-128 

Antimony Sb-115, Sb-116, Sb-116m, Sb-117, Sb- Sb-111, Sb-113, Sb-114, Sb-118, Sb- 
122m, Sb-124m, Sb-130m, Sb-133 118m, Sb-119, Sb-120, Sb-120m, Sb- 

122, Sb-124, Sb-124n, Sb-125, Sb-126, 
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Element Internal & External Dose 
Conversion Factors 

External Dose Conversion 
Factors Only 

Sb-126m, Sb-127, Sb-128, Sb-128m,  
Sb-129, Sb-130, Sb-131  

Tellurium Te-114, Te-116, Te-117, Te-118, Te- Te-113, Te-115, Te-115m 
119, Te-119m, Te-121, Te-121m, Te- 
123, Te-123m, Te-125m, Te-127, Te- 
127m, Te-129, Te-129m, Te-131, Te- 
131m, Te-132, Te-133, Te-133m, Te- 
134 

Iodine I-118, I-119, I-120, I-120m, I-121, I-123, I-118m, I-122, I-130m, I-134m 
I-124, I-125, I-126, I-128, I-129, I-130, I- 
131, I-132, I-132m, I-133, I-134, I-135 

Xenon Xe-120, Xe-121, Xe-122, Xe-123, Xe- 
125, Xe-127, Xe-127m, Xe-129m, Xe- 
131m, Xe-133, Xe-133m, Xe-135, Xe- 
135m, Xe-137, Xe-138 

Cesium Cs-125, Cs-127, Cs-129, Cs-130, Cs- Cs-121, Cs-121m, Cs-123, Cs-124, Cs- 
126, Cs-128, Cs-130m, Cs-138m, Cs- 
139, Cs-140 

131, Cs-132, Cs-134, Cs-134m, Cs-135, 
Cs-135m, Cs-136, Cs-137, Cs-138 

Barium Ba-124, Ba-126, Ba-127, Ba-128, Ba- Ba-137m 
129, Ba-129m, Ba-131, Ba-131m, Ba- 
133, Ba-133m, Ba-135m, Ba-139, Ba- 
140, Ba-141, Ba-142 

Lanthanum La-129, La-131, La-132, La-132m, La- La-128, La-130, La-134, La-136 
133, La-135, La-137, La-138, La-140, 
La-141, La-142, La-143 

Cerium Ce-130, Ce-131, Ce-132, Ce-133, Ce- Ce-145 
133m, Ce-134, Ce-135, Ce-137, Ce- 
137m, Ce-139, Ce-141, Ce-143, Ce-144 

Praseodymium Pr-134, Pr-134m, Pr-135, Pr-136, Pr- Pr-138, Pr-140, Pr-144m, Pr-148, Pr- 
148m 137, Pr-138m, Pr-139, Pr-142, Pr-142m, 

Pr-143, Pr-144, Pr-145, Pr-146, Pr-147 
Neodymium Nd-135, Nd-136, Nd-137, Nd-138, Nd- Nd-134, Nd-141m 

139, Nd-139m, Nd-140, Nd-141, Nd-144, 
Nd-147, Nd-149, Nd-151, Nd-152 

Promethium Pm-141, Pm-143, Pm-144, Pm-145, Pm- Pm-136, Pm-137m, Pm-139, Pm-140, 
Pm-140m, Pm-142, Pm-152, Pm-152m, 
Pm-153, Pm-154, Pm-154m 

146, Pm-147, Pm-148, Pm-148m, Pm- 
149, Pm-150, Pm-151 

Samarium Sm-140, Sm-141, Sm-141m, Sm-142, Sm-139, Sm-143, Sm-143m, Sm-157 
Sm-145, Sm-146, Sm-147, Sm-148, Sm- 
151, Sm-153, Sm-155, Sm-156 

Europium Eu-145, Eu-146, Eu-147, Eu-148, Eu- Eu-142, Eu-142m, Eu-143, Eu-144 
149, Eu-150, Eu-150m, Eu-152, Eu- 
152m, Eu-152n, Eu-154, Eu-154m, Eu- 
155, Eu-156, Eu-157, Eu-158, Eu-159 

Gadolinium Gd-145, Gd-146, Gd-147, Gd-148, Gd- Gd-142, Gd-143m, Gd-144, Gd-145m, 
Gd-162 149, Gd-150, Gd-151, Gd-152, Gd-153, 

Gd-159 
Terbium Tb-147, Tb-148, Tb-149, Tb-150, Tb- Tb-146, Tb-147m, Tb-148m, Tb-149m, 

Tb-150m, Tb-151m, Tb-152m, Tb-162, 
Tb-164, Tb-165 

151, Tb-152, Tb-153, Tb-154, Tb-155, 
Tb-156, Tb-156m, Tb-156n, Tb-157, Tb- 
158, Tb-160, Tb-161, Tb-163 
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Element Internal & External Dose 
Conversion Factors 

External Dose Conversion 
Factors Only 

Dysprosium Dy-151, Dy-152, Dy-153, Dy-154, Dy- Dy-148, Dy-149, Dy-150, Dy-165m, Dy- 
167, Dy-168 155, Dy-157, Dy-159, Dy-165, Dy-166 

Holmium Ho-154, Ho-155, Ho-156, Ho-157, Ho- Ho-150, Ho-153, Ho-153m, Ho-154m, 
Ho-168, Ho-168m, Ho-170 159, Ho-160, Ho-161, Ho-162, Ho-162m, 

Ho-163, Ho-164, Ho-164m, Ho-166, Ho- 
166m, Ho-167 

Erbium Er-156, Er-159, Er-161, Er-163, Er-165, Er-154, Er-167m, Er-173 
Er-169, Er-171, Er-172 

Thulium Tm-161, Tm-162, Tm-163, Tm-165, Tm- Tm-164, Tm-174, Tm-176 
166, Tm-167, Tm-168, Tm-170, Tm-171, 
Tm-172, Tm-173, Tm-175 

Ytterbium Yb-162, Yb-163, Yb-164, Yb-166, Yb- Yb-165, Yb-179 
167, Yb-169, Yb-175, Yb-177, Yb-178 

Lutetium Lu-165, Lu-167, Lu-169, Lu-170, Lu-171, Lu-169m, Lu-171m, Lu-172m, Lu-180, 
Lu-181 Lu-172, Lu-173, Lu-174, Lu-174m, Lu- 

176, Lu-176m, Lu-177, Lu-177m, Lu- 
178, Lu-178m, Lu-179 

Hafnium Hf-170, Hf-172, Hf-173, Hf-174, Hf-175, Hf-167, Hf-169 
Hf-177m, Hf-178m, Hf-179m, Hf-180m, 
Hf-181, Hf-182, Hf-182m, Hf-183, Hf-184 

Tantalum Ta-172, Ta-173, Ta-174, Ta-175, Ta- Ta-170, Ta-178 
176, Ta-177, Ta-178m, Ta-179, Ta-180, 
Ta-182, Ta-182m, Ta-183, Ta-184, Ta- 
185, Ta-186 

Tungsten W-177, W-178, W-179, W-181, W-185, W-179m, W-185m 
W-187, W-188, W-190 

Rhenium Re-178, Re-179, Re-181, Re-182, Re- Re-180, Re-190 
182m, Re-183, Re-184, Re-184m, Re- 
186, Re-186m, Re-187, Re-188, Re- 
188m, Re-189, Re-190m 

Osmium Os-180, Os-181, Os-182, Os-183, Os- Os-190m 
183m, Os-185, Os-186, Os-189m, Os- 
191, Os-191m, Os-193, Os-194, Os-196 

Iridium Ir-182, Ir-183, Ir-184, Ir-185, Ir-186, Ir- Ir-180, Ir-191m, Ir-192m, Ir-196 
186m, Ir-187, Ir-188, Ir-189, Ir-190, Ir- 
190m, Ir-190n, Ir-192, Ir-192n, Ir-193m, 
Ir-194, Ir-194m, Ir-195, Ir-195m, Ir-196m 

Platinum Pt-184, Pt-186, Pt-187, Pt-188, Pt-189,  
Pt-190, Pt-191, Pt-193, Pt-193m, Pt-  
195m, Pt-197, Pt-197m, Pt-199, Pt-200,  
Pt-202  

Gold Au-186, Au-190, Au-191, Au-192, Au- Au-187, Au-193m, Au-195m, Au-202 
193, Au-194, Au-195, Au-196, Au-196m, 
Au-198, Au-198m, Au-199, Au-200, Au- 
200m, Au-201 

Mercury Hg-190, Hg-191m, Hg-192, Hg-193, Hg- Hg-205, Hg-206, Hg-207 
193m, Hg-194, Hg-195, Hg-195m, Hg- 
197, Hg-197m, Hg-199m, Hg-203 

Thallium Tl-194, Tl-194m, Tl-195, Tl-196, Tl-197, Tl-190, Tl-190m, Tl-206, Tl-206m, Tl- 
207, Tl-208, Tl-209, Tl-210 Tl-198, Tl-198m, Tl-199, Tl-200, Tl-201, 

Tl-202, Tl-204 
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Lead Pb-194, Pb-195m, Pb-196, Pb-197m, Pb-197, Pb-201m 
Pb-198, Pb-199, Pb-200, Pb-201, Pb- 
202, Pb-202m, Pb-203, Pb-204m, Pb- 
205, Pb-209, Pb-210, Pb-211, Pb-212, 
Pb-214 

Bismuth Bi-200, Bi-201, Bi-202, Bi-203, Bi-204, Bi-197, Bi-211, Bi-212n, Bi-215, Bi-216 
Bi-205, Bi-206, Bi-207, Bi-208, Bi-210, 
Bi-210m, Bi-212, Bi-213, Bi-214 

Polonium Po-203, Po-204, Po-205, Po-206, Po- Po-211, Po-212, Po-212m, Po-213, Po- 
207, Po-208, Po-209, Po-210 214, Po-215, Po-216, Po-218 

Astatine At-205, At-206, At-207, At-208, At-209, At-204, At-215, At-216, At-217, At-218, 
At-210, At-211 At-219, At-220 

Radon  Rn-207, Rn-209, Rn-210, Rn-211, Rn- 
 212, Rn-215, Rn-216, Rn-217, Rn-218, 
 Rn-219, Rn-220, Rn-222, Rn-223 

Francium Fr-212, Fr-222, Fr-223 Fr-219, Fr-220, Fr-221, Fr-224, Fr-227 
Radium Ra-223, Ra-224, Ra-225, Ra-226, Ra- Ra-219, Ra-220, Ra-221, Ra-222 

227, Ra-228, Ra-230 
Actinium Ac-224, Ac-225, Ac-226, Ac-227, Ac-228 Ac-223, Ac-230, Ac-231, Ac-232, Ac-233 
Thorium Th-226, Th-227, Th-228, Th-229, Th- Th-223, Th-224, Th-235 

230, Th-231, Th-232, Th-233, Th-234, 
Th-236 

Protactinium Pa-227, Pa-228, Pa-229, Pa-230, Pa- Pa-234m, Pa-236, Pa-237 
231, Pa-232, Pa-233, Pa-234, Pa-235 

Uranium U-230, U-231, U-232, U-233, U-234, U- U-227, U-228 
235, U-235m, U-236, U-237, U-238, U- 
239, U-240, U-242 

Neptunium Np-232, Np-233, Np-234, Np-235, Np- Np-240m, Np-242, Np-242m 
236, Np-236m, Np-237, Np-238, Np-239, 
Np-240, Np-241 

Plutonium Pu-232, Pu-234, Pu-235, Pu-236, Pu-  
237, Pu-238, Pu-239, Pu-240, Pu-241,  
Pu-242, Pu-243, Pu-244, Pu-245, Pu-  
246  

Americium Am-237, Am-238, Am-239, Am-240, Am-  
241, Am-242, Am-242m, Am-243, Am-  
244, Am-244m, Am-245, Am-246, Am-  
246m, Am-247  

Curium Cm-238, Cm-239, Cm-240, Cm-241,  
Cm-242, Cm-243, Cm-244, Cm-245,  
Cm-246, Cm-247, Cm-248, Cm-249,  
Cm-250, Cm-251  

Berkelium Bk-245, Bk-246, Bk-247, Bk-248m, Bk-  
249, Bk-250, Bk-251  

Californium Cf-244, Cf-246, Cf-247, Cf-248, Cf-249,  
Cf-250, Cf-251, Cf-252, Cf-253, Cf-254,  
Cf-255  

Einsteinium Es-249, Es-250, Es-250m, Es-251, Es-  
253, Es-254, Es-254m, Es-255, Es-256  

Fermium Fm-251, Fm-252, Fm-253, Fm-254, Fm-  
255, Fm-256, Fm-257  
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